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Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©July 2010

Trademarks
Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
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Preface
R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Direc-
tive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

CE Marking
This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark
is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
II



Preface
FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.

And

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.
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Preface
FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This 
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator 
and your body.


Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3.75G modules, then the appropriate antennas will be installed.
Note that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate
in conjunction with any other antenna or transmitter.

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module and the Bluetooth/Wireless LAN
modules at the same time as this may disrupt radio frequency, and cause interference. When the 3.75G/HSPA module is
powered on, make sure that the Bluetooth/Wireless LAN modules are powered off.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC 

Output of 20V, 6A OR 19V, 9.47A minimum AC/DC Adapter.

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELE-
COMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
V



Preface
Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the com-
puter in a humid environment.

Do not place the computer on 
any surface that will block the 
Vents/Fan Intakes.
VI



Preface
3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
VII
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a steady, 

uninterrupted power supply. If you are unsure of your local power specifications, consult 
your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong 
is an important safety feature; do not defeat its purpose. If you do not have access to a 
compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by 
its wire.

• Make sure the socket and any extension cord(s) you use can support the total current load 
of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power sup-
plies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.


Power Safety 

Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
VIII
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

• Polymer batteries may experience a slight expansion or swelling, however this is part of the battery’s safety mecha-
nism and is not a cause for concern.

• Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
IX
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• If you do not use the battery for an extended period, then remove the battery from the computer for storage.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.


Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
X
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.


Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
XI
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your documents are prepared.


Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
XII
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
XIII
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on 
a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles 

when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent 

and short breaks are better than fewer and longer breaks.
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.

NVIDIA 3D Vision Kit Safety
Make sure you read all the enclosed safety instructions and precautions included in the NVIDIA 3D Vision Kit
before setting up the 3D Glasses and IR Emitter. Follow the setup instructions provided in the documentation to
set up the 3D Vision kit safely and take the “User Vision Test,” which will initiate when you turn on your Ge-
Force 3D Vision for the first time. If you cannot see the image in 3D during the test, you should DISCONTINUE
USE IMMEDIATELY. Continued use may result in health-related complications.
XV
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Quick Start Guide 1
Chapter 1: Quick Start Guide

Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, 7-in-1 card reader, ExpressCard 34/54), TouchPad & Mouse, Audio & Printer.

• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s Bluetooth, PC Camera, Wireless LAN, Fingerprint, 3.75G/

HSPA, TV Tuner and RAID modules (some of which may be optional depending on your pur-
chase configuration).

• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the NVIDIA Video driver controls.
• Appendix C Information on the ATI Video driver controls.
• Appendix D The computer’s specification.
• Appendix E Information specific to the Windows 7 OS.
Overview 1 - 1
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in the Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page  A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the
 symbol. Also please note the safety and handling instructions as indicated in the Preface.


Notes

Check the light colored
boxes with the mark
above to find detailed in-
formation about the com-
puter’s features. 
1 - 2 Overview
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Not Included
Operating Systems (e.g. Windows Vista/Windows 7) and applications (e.g. word processing, spreadsheet and da-
tabase programs) have their own manuals, so please consult the appropriate manuals.



Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn’t been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See Appendix A for a description of the interface (ports & jacks) which allow your computer to communicate with external
devices, connect to the internet etc.
Overview 1 - 3
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System Startup
1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter.
5. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 120 degrees); use the other 

hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by 
the lid/LCD).

Figure 1 - 1 - AC/DC Adapter In & Opening the Lid/LCD


Shutdown

Note that you should always shut your computer down by choosing the Shut Down command from the bottom right of the
Start menu in Windows 7 or from the Lock Button Menu in Windows Vista. This will help prevent hard disk or system
problems.
1 - 4 Overview
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System Software
Your computer may already come with system software pre-installed. Where this is
not the case, or where you are re-configuring your computer for a different system,
you will find the following operating systems are supported.

Table 1 - 1 - Operating Systems Supported

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the
Windows OS (see “Setting Up SATA RAID or AHCI Modes” on page 7 - 52).

Operating System & Version Note

Windows Vista - with Service Pack 2 In order to run Windows Vista/Windows 7
without limitations or decreased performance,
your computer requires a minimum 1GB of
system memory (RAM).

Windows 7


TV Tuner Module 

Support

Note that the TV Tuner
module (factory option) in
Windows is supported by
the Windows Media Cen-
ter software which comes
built-in to the Windows
Vista Home Premium and
Ultimate Editions only. 

If your purchase includes a
TV Tuner option, and you
are re-configuring your sys-
tem for a different system,
you should install either
Home Premium or Ulti-
mate Editions of Windows
Vista only. Note that Win-
dows Media Center is not
included in Starter or
Home Basic versions of
Windows 7.


Windows Vista/Windows 7

This manual refers to the Windows Vista OS. For any information specific to Windows 7 see Ap-
pendix E. Make sure you install Windows Vista Service Pack 2 (or a Windows Vista version which
includes Service Pack 2) before installing any drivers. Go to the Microsoft website for download
details, or contact your service center.
Overview 1 - 5
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Model Differences
This notebook series includes four different model types that mainly differ as indicated in the table below.

Table 1 - 2 - Model Differences

Feature Model A Model B Model C Model D

Display Type 
Supported

15.6” (39.62cm) HD (1366 * 
768) / HD+ (1600 * 900) / 
FHD (1920 * 1080) 16:9 
Wide Screen LED Panel

17.3" FHD (1920 * 1080) / HD+ (1600 * 900) 16:9 Wide 
Screen LED Backlit Panel

15.6” (39.62cm) HD (1366 * 
768) 120Hz panel to support 

3D solution with NV 
3DVISION shutter glasses 

kit, and compatible with GTX 
285M and GTS 360M Video 

Cards

RAID Supported Not Supported RAID Level 0/1 Supported Not Supported

Mini-Card Slot 2
for UMTS/HSPA 3.75G 

Module
for TV Tuner Card

for UMTS/HSPA 3.75G 
Module

CPUs & Video 
Adapters 

Supported
See “Specifications” on page D - 1 for a full list of CPUs and video adapters supported by each model.

Design
See “System Map: Front View - Models A & D” on page 1 - 7 and “System Map: Front View - Models B & C” on 

page 1 - 8 to help identify your particular model.

AC/DC Adapter DC Output 20V, 6.0A DC Output 19V, 9.48A DC Output 20V, 6.0A
1 - 6 Model Differences
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System Map: Front View - Models A & D Figure 1 - 2
Front View

(Model A & D 
Computers)

1. Built-In PC Camera 
(Optional)

2. LCD
3. Power Button
4. Speakers
5. LED Hot Key 

Buttons
6. LED Status 

Indicators
7. Keyboard
8. Built-In Microphone
9. Touchpad & 

Buttons
10. LED Power 

Indicators

Note: The Fingerprint Reader
module is optional for Model
A & D computers.

2

5

1

7

46


Wireless Device 

Operation Aboard Aircraft

The use of any portable electronic transmission
devices aboard aircraft is usually prohibited.
Make sure the module(s) are OFF if you are us-
ing the computer aboard aircraft.

Use the key combinations to toggle power to

the 3.75G/HSPA/WLAN/Bluetooth modules,

and check the LED indicator icon to see if the

modules are powered on or not (see Table 1 -
6, on page 1 - 12/ Table 1 - 4, on page 1
- 9).

Note that the Touchpad and Buttons
valid operational area is that indicated
within the red dotted lines above.

9

8

4

3

10

9

System Map: Front View - Models A & D 1 - 7
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System Map: Front View - Models B & CFigure 1 - 3
Front View

(Model B & C 
Computers)

1. Built-In PC Camera 
(Optional)

2. LCD
3. LED Status 

Indicators
4. LED Hot Key 

Buttons
5. LED Power Button
6. Speakers
7. Keyboard
8. Built-In Microphone
9. Touchpad & 

Buttons
10. Consumer Infrared 

Transceiver (for 
Optional TV Tuner)

11. LED Power 
Indicators

Note: The Fingerprint Reader
module is optional for Model
B & C computers.

2

6

1

8

9

5

7


Wireless Device 

Operation Aboard Aircraft

The use of any portable electronic trans-
mission devices aboard aircraft is usually
prohibited. Make sure the module(s) are
OFF if you are using the computer
aboard aircraft.

Use the key combinations to toggle pow-

er to the WLAN/Bluetooth modules, and

check the LED indicator icon to see if the

modules are powered on or not (see

Table 1 - 6, on page 1 - 12/ Table 1
- 4, on page 1 - 9).

9

10

6

6 6

11

3 4

Note that the Touchpad and But-
tons valid operational area is that
indicated within the red dotted
lines above.
1 - 8 System Map: Front View - Models B & C
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LED Indicators
The LED indicators on the LED strip just below the
LCD panel on the computer display helpful informa-
tion about the current status of the computer when il-
luminated. 

Table 1 - 3 - LED Status Indicators

A further two LED power indicators on the front right
of the computer provide information on the comput-
er’s power status.

Table 1 - 4 - LED Power Indicators

Icon Description

Hard Disk Activity

Number Lock Activated
(to activate press Fn & Num Lk)

Caps Lock Activated

Scroll Lock Activated 
(to activate press Fn & Scr Lk)

The (optional) Wireless LAN Module is Powered 
On

The (optional) Bluetooth Module is Powered On

Icon Color Description

Orange DC Power is Plugged In

Green The Computer is On

Blinking Green
The Computer is in Sleep 

Mode

Orange The Battery is Charging

Green The Battery is Fully Charged

Blinking Orange
The Battery Has Reached 
Critically Low Power Status
LED Indicators 1 - 9
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Hot Key Buttons & Keyboard
The LED hot key buttons give instant access to the default Internet browser and e-
mail program, and allow you to toggle Silent Mode with one quick button press.

Table 1 - 5 - LED Hot Key Buttons

*When enabled, Silent Mode will reduce fan noise and save power consumption.
Note this may reduce computer performance.

Hot Key Function

Activate the Default E-Mail Browser (Note that In Windows 7 without Outlook/
Outlook Express installed this button has no function. If Outlook/Outlook Express are
installed then the button will activate the application)

 Activate the Default Internet Program

Toggle *Silent Mode (for power saving)


Other Keyboards

If your keyboard is
damaged or you just
want to make a
change, you can use
any standard USB key-
board. The system will
detect and enable it
automatically. Howev-
er special functions/
hot-keys unique to the
system’s regular key-
board may not work.

NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable num-
ber or scroll lock, and
check the LED indica-
tor for status.



Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLk is on.
1 - 10 Hot Key Buttons & Keyboard
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Keyboard
The keyboard has a numerical keypad on the right for easy numeric data input, and features function keys to
allow you to change operational features instantly. See Table 1 - 6, on page 1 - 12 for full function key combi-
nation details.

Figure 1 - 4 - Keyboard

Numerical Keypad 

Play/Pause Key

Function Keys NumLk & 
ScrLk Keys

Fn Key
Keyboard 1 - 11
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Function/Hot Key Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations, visual indicators are available when the hot key utility is installed.

Table 1 - 6 - Function & Hot Key Indicators

Fn Keys Function Fn Keys Function

Fn + ~ Play/Pause (in Audio/Video Programs) Fn + F5/F6 Volume Decrease/Increase

Fn + _ 
3.75G Module Power 

Toggle*
Fn + F7 Display Toggle

Fn + F1 Touchpad Toggle Fn + F8/F9
Brightness Decrease/

Increase

Fn + F2
Turn LCD Backlight Off

(Press a key to or use TouchPad to turn on)
Fn + F10

PC Camera Power 
Toggle

Fn + F3 Mute Toggle Fn + F11
**WLAN Module Power 

Toggle

Fn + F4  Sleep Toggle Fn + F12
Bluetooth Module Power 

Toggle

*Silent Mode Toggle  

*When enabled, Silent Mode will reduce fan noise and save power 
consumption. Note this may reduce computer performance.

**Make sure that Wireless is ON in the Windows Mobility Center to ensure 
proper wireless function key behavior (see page 3 - 11).
1 - 12 Function/Hot Key Indicators
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System Map: Left View Figure 1 - 5
Left View

1. RJ-11 Modem Jack
2. USB 2.0 Port
3. Mini-IEEE 1394 

Port
4. 7-in-1 Card Reader
5. Optical Device 

Drive Bay (for DVD 
Device)

6. Cable (CATV) 
Antenna Jack*

*Enabled with Optional TV
Tuner for Models B & C On-
ly.

Note that your model’s color
may differ from that pictured.

6 231 54



7-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / 
MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) / 

Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

Mini-IEEE 1394 Port

The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices. Make sure
you install the Firewire IEEE 1394 driver (see page 4 - 6).

5

Models A & D

Models B & C

1 2 3 4
System Map: Left View 1 - 13
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
Disk Eject Warning

Don’t try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don’t try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.


Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code
(see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.
1 - 14 System Map: Left View
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System Map: Right View Figure 1 - 6
Right View

1. Headphone-Out 
Jack

2. Microphone-In 
Jack

3. Line-In Jack
4. S/PDIF-Out Jack
5. USB 3.0 Port OR 

USB 2.0 Port
6. ExpressCard Slot 

(see page 2 - 7)
7. e-SATA Port 
8. DVI-Out Port
9. Security Lock Slot 

(Models B & C 
Only)

10. Power Button 
(Models A & D 
Only)

1
5

2 4
8

3
6 7

Models A & D 10



USB 3.0 Port OR USB 2.0 Port

All computer models have either a single USB 3.0 port or USB 2.0 port on the right side of
the computer. The USB 3.0 port is denoted by its blue color; USB 2.0 ports are colored
black.

Note that the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7/
.“USB 3.0” on page E - 31).

Models B & C

1 2 43
5 6 7 8 9
System Map: Right View 1 - 15
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System Map: Rear ViewFigure 1 - 7
Rear View

1. Vent/Fan Intake/
Outlet

2. Security Lock 
Slot (Models A & 
D Only)

3. HDMI-Out Port
4. DC-In Jack
5. 2 * USB 2.0 Ports
6. RJ-45 LAN Jack
7. Rear Cover 

(Models B & C 
Only)


Overheating

To prevent your comput-
er from overheating
make sure nothing
blocks the vent(s)/fan in-
take(s) while the com-
puter is in use.

1 3 54

7

1



HDMI-Out Port

Note that the HDMI-Out Port supports video and audio signals to attached external dis-
plays (also see “HDMI Audio Configuration” on page B - 11).

Models A & D

Models B & C

1 12 3 4 5
6

6

1 - 16 System Map: Rear View
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System Map: Bottom View - Models A & D 
Figure 1 - 8

Bottom View
(Model A & D 
Computers) 

1. Battery
2. Component Bay 

Cover
3. Vent/Fan Intake/

Outlet

Note: the 3.75G/HSPA
USIM Card is located un-
der the Component Bay
Cover.

2

1

3 3


Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharges.
See “Battery Information”
on page 3 - 10 for full in-
structions.


CPU

The CPU is not a user serviceable part.

Overheating

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.

3

3

3

System Map: Bottom View - Models A & D 1 - 17
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System Map: Bottom View - Model B 
Figure 1 - 9

Bottom View
(Model B 

Computers)

1. Battery
2. Component Bay 

Cover
3. Vent/Fan Intake/

Outlet
4. Subwoofer

2

3

1 3

3


Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharges.
See “Battery Information”
on page 3 - 10 for full in-
structions.


CPU

The CPU is not a user serviceable part.

Overheating

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.

3
33

4

1 - 18 System Map: Bottom View - Model B
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System Map: Bottom View - Model C 
Figure 1 - 10
Bottom View

(Model C 
Computers) 

1. Battery
2. Component Bay 

Cover
3. Vent/Fan Intake/

Outlet
4. Subwoofer

2

3

1 3

3


Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharges.
See “Battery Information”
on page 3 - 10 for full in-
structions.


CPU

The CPU is not a user serviceable part.

Overheating

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.

3
33

4

System Map: Bottom View - Model C 1 - 19
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Windows Vista Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers listed
in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle to Classic View on.

Figure 1 - 11 - Start Menu & Control Panel

Click here to toggle Classic View
 

1 - 20 Windows Vista Start Menu & Control Panel
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Video Features
This computer features two different (either ATI or NVIDIA) video options. You will be provided with an ap-
propriate driver on the Device Drivers & Utilities + User’s Manual Disc. You can configure display options, from
the Display Settings control panel in Windows. To access Display Settings in Windows:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click 

Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution:  (Figure 1 - 12 on page 1 - 22).
4. Click the arrow, and scroll to the preferred setting In Colors: (Figure 1 - 12 on page 1 - 22).
5. Click Advanced Settings (button)  (Figure 1 - 12 on page 1 - 22).

To access the NVIDIA Control Panel (See Appendix B for detailed information):
1. Click Advanced Settings (button)  (Figure 1 - 12 on page 1 - 22).
2. Click GeForce..... (tab)  (Figure 1 - 12 on page 1 - 22).
3. Click Start the NVIDIA Control Panel  (Figure 1 - 12 on page 1 - 22) to access the control panel.

To access the ATI Catalyst Control Center (See Appendix C for detailed information):
1. Click Advanced Settings (button)  (Figure 1 - 12 on page 1 - 22).
2. Click ATI Catalyst Control Center (tab)  (Figure 1 - 12 on page 1 - 22).
3. Click ATI Catalyst Control Center (button)  (Figure 1 - 12 on page 1 - 22) to access the control panel.

1
2

3

3
4

5

3
6

7

Video Features 1 - 21
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Figure 1 - 12 - Display Settings & NVIDIA/ATI Controls

1 2

3

4

1 2

3

7

5

6

1 - 22 Video Features
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 18) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 10.

Figure 1 - 13 - Power Options

Note: Sleep is the default power saving state in Windows Vista
Power Options 1 - 23
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2
Chapter 2: Features & Components

Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Optical (CD/DVD) Device
• 7-in-1 Card Reader
• ExpressCard Slot
• TouchPad and Buttons/Mouse
• Gesture Configuration
• Audio Features
• Audio Setup for LCD Monitors/TVs with HDMI Input
• Adding a Printer
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive is used to store your data in the computer. The hard disk can be
taken out to accommodate other 2.5" serial (SATA) hard disk drives (see “Storage”
on page D - 5) with a height of 9.5 mm.

The primary hard disk is accessible from the bottom of your computer as seen below.
For further details see “Upgrading the Hard Disk Drive(s)” on page 6 - 4.


Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

Figure 2 - 1
Hard Disk Location


Pictures

Note that only one model is pictured,
however the primary hard disk location is
the same for all models.
2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the module you purchased (see “Storage” on page D - 5). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Boot Menu” on page 5 - 12).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator  will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole

 to open the tray.


Sound Volume 

Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting (see
“Sound Volume Ad-
justment” on page 2 -
10).

 Figure 2 - 2
Optical Device

1

2

3

12 3
Optical (CD/DVD) Device 2 - 3
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Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.


CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 14.
.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, South 

Korea, The Philippines, Indonesia, 
Hong Kong

4
South & Central America, Mexico, 

Australia, New Zealand

5 N Korea, Russia, Eastern Europe, 
India & Most of Africa

6 China

Table 2 - 1
DVD Regional Coding
Optical (CD/DVD) Device 2 - 5
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 7-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “CardReader” on page 4 - 7).

*Note: The PC adapters are usually supplied with these cards.


Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

 Figure 2 - 3
Left View

1. Card Reader

• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS Pro (Memory Stick Pro)

• MS Duo (requires PC adapter*)
• Mini SD (requires PC adapter*)
• RS MMC (requires PC adapter*)

Models A & D

Models B & C

1

1

2 - 6 7-in-1 Card Reader
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ExpressCard Slot
The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards). Make sure you install the Card Reader driver (see “CardReader” on page 4
- 7).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34.

Inserting and Removing ExpressCards
• Align the ExpressCard with the slot and push it in until it locks into place (as 

pictured in the generic figure below).
• To remove an ExpressCard, simply press the card to eject it.


ExpressCard 

Slot Cover

Make sure you keep the
rubber cover provided in
the ExpressCard slot
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the Express-
Card Slot.

 Figure 2 - 4
Left View

1. Express Card 
Slot

 Figure 2 - 5
Inserting & 

Removing Express 
Cards

11

Models A & D Models B & C
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 TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse. 

Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 7) you
can configure the functions by double-clicking the TouchPad driver icon  on the
taskbar. You may then configure the TouchPad tapping, buttons, scrolling (tap the
top and bottom right of the TouchPad to scroll), pointer motion and sensitivity op-
tions to your preferences.


TouchPad Scrolling

This computer model se-
ries may feature different
TouchPad versions.

These TouchPads may
differ in their vertical
scrolling function in most
scrollable windows.

Some TouchPads require
sliding the finger up and
down on the right of the
TouchPad to scroll the
window. Other versions
require tapping/holding
down the finger at the top
right or bottom right of the
TouchPad to scroll the
window.

 Figure 2 - 6
Mouse Properties
2 - 8 TouchPad and Buttons/Mouse
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Gesture Configuration
The Gesture Configuration control allows you to configure specific gesture func-
tion settings on the surface of the TouchPad for various applications.

You can configure Gestures from the Finger-sensing Pad tab in Mouse Properties:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mouse (Hardware and Sound).
3. Click Finger-sensing Pad (tab) and select Click On Pad from Available 

information and configuration items.
4. Click Configure in Gesture Configuration to access the user configurable settings.


Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

 Figure 2 - 7
Mouse Properties - 

Gesture 
Configuration
TouchPad and Buttons/Mouse 2 - 9
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 Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the taskbar/
control panel (right-click the taskbar  icon bring up an audio menu). The volume
may also be adjusted by means of the Fn + F5/F6 key combination. 


Sound Volume 

Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to
check the setting.

 Figure 2 - 8
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.
2 - 10 Audio Features
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Audio Setup for LCD Monitors/TVs with HDMI Input
Some LCD monitors/TVs support HDMI input, but DO NOT have built-in digital
audio decoders. Where this is the case, when playing DVDs in Windows Media
Player/CyberLink Power DVD etc., a background noise can occur. If this situation
does arise then please follow the instructions below.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Double-click Realtek Digital Output.
4. Click Supported Formats (tab).
5. Click to disable (remove the check in the box) DTS Audio and Dolby Digital.
6. Click OK and close the control panels.

 Figure 2 - 9
Sound 

Supported Formats
Audio Features 2 - 11
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 Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-

tridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you 

to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.


Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
2 - 12 Adding a Printer
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Chapter 3: Power Management

Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system. This chapter covers:

• The Power Sources
• Turning on the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.


OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows
Vista OS.)

Hibernate Mode In 
Windows Vista SP1

If you are using Win-
dows Vista SP1 with
4GB RAM installed, see
page 8 - 12 for informa-
tion on Hibernate.
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 14).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 10.


Silent Mode

Use the  key to tog-
gle Silent Mode to re-
duce fan noise and save
power consumption.
Note this may reduce
computer performance.
3 - 2 The Power Sources
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Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Sleep/Hibernate hot-
key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down). Use Power Op-
tions (Hardware and Sound menu) control panel in Windows Vista to configure
this feature.


Shut Down

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
from the Lock Button
Menu in Windows Vis-
ta. This will help prevent
hard disk or system
problems.


Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow-
er button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep is the default power mode when the power button is pressed for less than 4 seconds.
You may configure the options for the power button from the Power Options (Hardware
and Sound menu) control panel in Windows Vista (see your OS’s documentation, or
“Configuring the Power Buttons” on page 3 - 8 for details).
Turning on the Computer 3 - 3
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.


Resuming 
Operation

See Table 3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 1
Power Plan 

Advanced Settings
3 - 4 Power Plans
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure 3 - 2
Power Plans
Power Plans 3 - 5
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Sleep is the default power-saving state in Windows Vista.

Earlier versions of Windows used Stand By and Hibernate as system power-saving
states. Windows Vista combines the features of Stand By and Hibernate into the de-
fault Sleep power-saving state.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.


Power Button

The Power Button 
in the Start Menu (in
Classic View use the
Shut Down button )
can be used to send the
computer into a power-
saving state.

Sleep Mode & 
Mobile PC Battery

A mobile PC in Sleep
uses very little battery
power. 

After an extended peri-
od of time the computer
will save any open docu-
ments and applications
to hard disk.
3 - 6 Power-Saving States
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut Down
You should shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from shut down takes longer than
from Sleep or Hibernate.


Hibernate Mode In 
Windows Vista SP1

If you are using Win-
dows Vista SP1 with
4GB RAM installed, see
page 8 - 12 for informa-
tion on Hibernate.

Figure 3 - 3
Lock Button Menu
Power-Saving States 3 - 7
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state.


Password 
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 4
Power Options 
Define Power 

Buttons
3 - 8 Configuring the Power Buttons
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad


Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table 3 - 1
Resuming 

Operation


Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).
Configuring the Power Buttons 3 - 9
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon  in the taskbar to see the current battery level and charge
status.


Low Battery 

Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 5
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
3 - 10 Battery Information
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.


Wireless Hot Keys

The computer’s wireless
function keys will not func-
tion properly if Wireless is
turned OFF in the Win-
dows Mobility Center
control panel.

The wireless indicators
 may show that

the WLAN module is pow-
ered on, however if wire-
less is OFF in the Mobility
Center, the module will not
be powered on. 

Make sure that Wireless is
ON in the Mobility Center to
ensure proper function key
behavior.

Figure 3 - 6
Windows Mobility 

Center


Windows Mobility 

Center

The Windows Mobili-
ty Center control pan-
el provides an easy
point of access for in-
formation on battery
status, power plans
used and wireless de-
vice status etc.

Make sure Wireless is ON to ensure proper function key behavior.
Battery Information 3 - 11
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see “Removing the Battery”
on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 9 for information on the battery charge status, and to “Battery In-
formation” on page 3 - 10 for more information on how to maintain and properly
recharge the battery pack.)
3 - 12 Battery Information
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other


Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.


Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
Battery Information 3 - 13
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after saving it) and click Change advanced power 

settings.

Figure 3 - 7
Power Plan Create
3 - 14 Battery Information
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 0%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 8
Power Options 

Advanced Settings - 
Battery
Battery Information 3 - 15
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.
3 - 16 Battery Information
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities. 

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to
be done prior to installing the Windows OS, and there-
fore before installing the other drivers listed here (see
“Setting Up SATA RAID or AHCI Modes” on page 7
- 52).

What to Install
The Device Drivers & Utilities + User’s Manual disc
contains the drivers and utilities necessary for the
proper operation of the computer.

Table 4 - 1, on page 4 - 3 lists what you need to install
and it is very important that the drivers are in-
stalled in the order indicated (see “Driver Installa-
tion” on page E - 27 for Windows 7 information).

Module Driver Installation
The procedures for installing drivers for the PC Cam-
era, Wireless LAN, Fingerprint, 3.75G/HSPA, TV
Tuner (Consumer Infrared), 3D Shutter Glasses
Kit and RAID modules are provided in “Modules &
Options” on page 7 - 1.
What to Install 4 - 1
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers/Option Drivers (button).

If you wish to install the drivers manually see overleaf
for the driver path information.

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driver installation order from Table 4 - 1, 
on page 4 - 3 (the drivers must be installed in 
this order) which is the same as that listed in the 
Drivers Installer menu below.

2. Click to select the driver you wish to install, (you 
should note down the drivers as you install them).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

Note: If you need to reinstall any driver, you should uninstall the

driver first.

 

Figure 4 - 2 - Drivers Installer Screen 2
4 - 2 Driver Installation
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Table 4 - 1 - Driver Installation

Manual Driver Installation
Click Browse CD/DVD (button) in the Drivers Installer application and browse to the executable file in the ap-
propriate driver folder.

Driver - Windows Vista with Service Pack 2 Page Driver - Windows Vista with Service Pack 2 Page

Chipset Page 4 - 5 PC Camera Module Page 7 - 8

NVIDIA Video
ATI Video

Page 4 - 6 Wireless LAN Module Page 7 - 17

Modem Page 4 - 6 Fingerprint Reader Module Page 7 - 22

LAN Page 4 - 6 3.75G/HSPA Module (Models A & D Only) Page 7 - 40

Firewire (IEEE 1394) Page 4 - 6 TV Tuner Module (Models B & C Only) Page 7 - 46

CardReader Page 4 - 7 NVIDIA 3D Shutter Glasses Kit Page 7 - 48

TouchPad Page 4 - 7
Setting Up SATA RAID or AHCI Modes 
(RAID for Models B & C Only)

Page 7 - 52

Hot Key Page 4 - 7

USB 3.0 Page 4 - 7

Audio Page 4 - 7
Driver Installation 4 - 3
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Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
8 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and 
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.


Windows Vista Service Pack 2

Make sure you install Windows Vista Service Pack 2
(or a Windows Vista version which includes Service
Pack 2) before installing any drivers. Go to the Micro-
soft website for download details, or contact your service
center.
4 - 4 Driver Installation
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User Account Control (Win Vista)
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.


Driver Installation General Guidelines

The driver installation procedure outlined in this
Chapter (and in Chapter 7 Options & Modules),
are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.
Driver Installation 4 - 5
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NVIDIA Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.
OR

ATI Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Install (button).
3. Click the Express (or Custom if you prefer to 

manually configure the driver installation set-
tings) button and click Next.

4. Click Accept (button) and click Yes.
5. Click Finish > Yes to restart the computer.

Modem
1. Click 3.Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.

LAN
Make sure you have plugged the network cable in be-
fore installing the driver.

1. Click 4.Install LAN Driver > Yes. 
2. Click Next > Install.
3. Click Finish.
4. The network settings can now be configured.

Firewire (IEEE 1394)
1. Click 5.FireWire drivers > Yes. 
2. Click Install.
3. Click Finish.
4 - 6 Driver Installation
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CardReader
1. Click 6.Install Cardreader Driver > Yes.
2. Click Install.
3. Click Finish.

TouchPad
1. Click 7.Install Touchpad Driver > Yes.
2. Choose the language you prefer and click OK.
3. Click Next > Finish.
4. Click Restart Now to restart the computer.

Hot Key
1. Click 8.Install Hotkey Utility > Yes. 
2. Click Next > Next.
3. Click Finish > Finish to restart the computer.

USB 3.0
1. Click 9.Install USB 3.0 Driver > Yes. 
2. Click Next.
3. Click the button to accept the license and then 

click Next.
4. Click Next > Install.
5. Click Finish.

Audio
1. Click 10.Install Audio Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, eject
the Device Drivers & Utilities + User’s Manual disc
and then reinsert it (or double-click the disc icon in My
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.
Driver Installation 4 - 7
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Optional Drivers
See the pages indicated for the driver installation pro-
cedures for any modules included in your purchase op-
tion.

Figure 4 - 3 - Drivers Installer - Option Drivers Menu


Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point 
to Settings and click Control Panel).

2. Click Check for updates (Security), or 
double-click Security Center and click 
Windows Update.

3. Double-click Check for updates (button).
4. The computer will now check for updates 

(you need to be connected to the internet).
5. Click Install now (button) to install the 

updates.
4 - 8 Driver Installation
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Bluetooth Module
Note: The operating system is the default setting for
Bluetooth control in Windows Vista, and does not re-
quire a driver. See “Bluetooth Module” on page 7 - 2
for configuration instructions.

PC Camera Module
See the introduction in “PC Camera Module” on
page 7 - 7, and check the installation procedure.

Wireless LAN Module
See the introduction in “Wireless LAN Module” on
page 7 - 16, and check the installation procedure.

Fingerprint Reader Module
See the introduction in “Fingerprint Reader Module”
on page 7 - 22, and check the installation procedure.

3.75G/HSPA Module (Models A & D Only)
See the introduction in “3.75G/HSPA Module” on
page 7 - 27, and check the installation procedure.

TV Tuner Module (Models B & C Only)
See the introduction in “TV Tuner Module” on page 7
- 45, and check the installation procedure for the Con-
sumer Infrared (CIR) driver.

NVIDIA 3D Shutter Glasses (Model D Only)
See the introduction in “NVIDIA 3D Shutter Glasses
Kit” on page 7 - 48. The NVIDIA Video Driver is re-
quired to support the 3D glasses.

RAID and AHCI Configuration 
(RAID for Models B & C Only)
See the configuration instructions in “Setting Up
SATA RAID or AHCI Modes” on page 7 - 52.
Driver Installation 4 - 9
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Chapter 5: BIOS Utilities

Overview
This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.


BIOS Screens

Note that the BIOS
screens pictured on the
following pages are in-
tended for guidance in
setting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on the
following pages. 
Overview 5 - 1
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The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.


BIOS Settings 

Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.
5 - 2 The Power-On Self Test (POST)



BIOS Utilities

5

Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup 

Press F1 to see if the boot process can continue. It may work, without the correct
configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.
The Power-On Self Test (POST) 5 - 3
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The Setup Program
The Phoenix Setup program tells the system how to configure itself and manage ba-
sic features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds
after you turn on the system. If you get a “Keyboard Error”, (usually because you
pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.
5 - 4 The Setup Program
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Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screen to
make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.


Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.
The Setup Program 5 - 5
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 1
Main Menu
5 - 6 Main Menu
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SATA Port 1/2/3/4/5 (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of an HDD/optical de-
vice on the computer’s SATA Port 1/2/3/4/5. Use the Auto (Type:) setting to have
the items configured automatically for you.

System/Extended Memory (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

BIOS Revision/KBC/EC Firmware Revision (Main Menu)
This item contains information on the current BIOS and firmware versions.

VGA Card/VBIOS Revision/VBIOS Build Date (Main Menu)
This item contains information on the current videos card installed, and on the Video
BIOS version.
Main Menu 5 - 7
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Advanced Menu

Advanced Chipset Control
The sub-menu here allows you to enable/disable Extreme Edition control, if appli-
cable to your system.
5 - 8 Advanced Menu
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SATA Mode Selection (Advanced Menu)
You may enable/disable SATA RAID or AHCI mode for your hard disks, however
you should only enable/disable RAID or AHCI BEFORE installing an operat-
ing system, and after you have backed up all necessary files and data (see sidebar).

Legacy USB Support (Advanced Menu)
Choose “Enabled” if you intend to use USB devices in systems which do not nor-
mally support USB functionality (e.g. DOS). The default setting is “Enabled” and
does not need to be changed if you intend to use your USB devices in Windows.

Boot-time Diagnostic Screen (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen or Power-On
Self Test.

Legacy OS Boot (Advanced Menu)
Enable this item to support only system boot from the Legacy OS (e.g Windows Vis-
ta). If disabled the system will attempt to boot from the EFI (Extensible Firmware
Interface) before the Legacy OS.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.


SATA Mode 

Selection

If you have installed the
Windows Vista operat-
ing system with either
AHCI or RAID mode en-
abled, DO NOT disable
the set mode (if you wish
to disable the set mode
you will need to reinstall
the Windows VIsta OS).

Figure 5 - 2
Advanced Menu
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Phoenix SecureCore Setup Utility. This
will not affect access to the computer OS, (only the Phoenix SecureCore Setup
Utility).


Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.

Figure 5 - 3
Security Menu
5 - 10 Security Menu
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Set User Password (Security Menu)
You can set a password for user mode access to the Phoenix SecureCore Setup
Utility. This will not affect access to the computer OS, (only the Setup utility) unless
you choose to set a Password on Boot (see below). Many menu items in the Phoenix
SecureCore Setup Utility cannot be modified in user mode. You can only set the
user password after you have set the supervisor password.

Password on boot (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”. 

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.


Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
Security Menu 5 - 11



BIOS Utilities

5

Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows
Vista) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.

Figure 5 - 4
Boot Menu
5 - 12 Boot Menu
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Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

Figure 5 - 5
Exit Menu
Exit Menu 5 - 13
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Chapter 6: Upgrading The Computer

Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive(s)
• Upgrading the Optical (CD/DVD) Device
• Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.


Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.

You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.


Power Safety 

Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.


Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.
6 - 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.

1. Turn the computer off, and turn it over.
2. Slide the latch  in the direction of the arrow.
3. Slide the latch  in the direction of the arrow, and hold it in place.
4. Lift the battery out in the direction of the arrow .


Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 1
Battery Removal


Pictures

Note that only one mod-
el is pictured, however
the primary hard disk lo-
cation is the same for all
models.

1
2

3

1

2

3
3
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Upgrading the Hard Disk Drive(s)
The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
disk drives with a height of 9.5mm (h) (see “Storage” on page D - 5). Follow your
operating system’s installation instructions, and install all necessary drivers and util-
ities (see “Driver Installation” on page 4 - 2), when setting up a new hard disk.

Removing the Hard Disk(s) in the Primary HDD Bay
1. Turn off the computer, and turn it over and remove the battery.
2. Remove screws  -  from the hard disk cover.
3. Slide the hard disk assembly in the direction of arrow .


HDD System 

Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Figure 6 - 2
Hard Disk Bay 
Cover Removal

1 2
3

Model B

3

1

2
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4. Lift the hard disk assembly out of the computer in the direction of arrow .
5. Remove the screws  -  and the cover bracket .
6. Reverse the process to install a new hard disk drive (do not forget to replace all the 

screws and covers).

4

Figure 6 - 3
HDD Assembly 

Removal

5 8 9

6

5

4

7

8

9


Hard Disk Screws & Cover

The hard disks and covers pictured here may appear slightly different from your model design (these
designs are subject to change and upgrade without notice). Pay careful attention to the screws and
cover bracket orientation.
Upgrading the Hard Disk Drive(s) 6 - 5
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Removing the Hard Disk in the Secondary HDD Bay
(Model B & C Computers Only)
If you want to configure your hard disks in a RAID configuration then install iden-
tical drives in the primary (see page 6 - 4) and secondary hard disk bays as per the
instructions here. Follow the instructions in “Setting Up SATA RAID or AHCI
Modes” on page 7 - 52 for configuration details. Note a RAID configuration is only
supported by Model B & C computers.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws  - .
3. Carefully remove the cover .


RAID Hard Disks

All hard disks in a RAID
should be identical (the
same size and brand) in
order to prevent unex-
pected system behavior.

Figure 6 - 4
Component Bay 
Cover Screws


Pictures

Note that only one mod-
el is pictured, however
the primary hard disk lo-
cation is the same for all
models.

1 11
12

3

1

2
Model B

52
1

4

6

78
9

3

1011

12
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4. Slide the hard disk assembly in the direction of the arrow .
5. Lift the hard disk  out of the compartment.
6. Remove screws  -  to separate the hard disk from the brackets.
7. Reverse the process to install a new hard disk drive (do not forget to replace all the 

screws and covers).


RAID Hard Disks

All hard disks in a RAID
should be identical (the
same size and brand) in
order to prevent unex-
pected system behavior.

Figure 6 - 5
Secondary HDD 

Removal
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
Hard Disk Screws & Cover

The hard disks and covers pic-
tured here may appear slightly
different from your model design
(these designs are subject to
change and upgrade without no-
tice). Pay careful attention to the
screws and cover bracket orien-
tation.
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Upgrading the Optical (CD/DVD) Device
1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws  -  (Models A & D) or 

 -  (Models B & C).

Figure 6 - 6
Component Bay 
Cover Screws

1 9
1 11

3

3
1

2
Model BModel BModels A & D

52
1

4

6

78
9

3

1011
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7
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Model C
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9
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1011
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3. Carefully remove the cover .

Figure 6 - 7
Removing the 

Component Bay 
Cover

12

Model BModels A & D

12

12

12

Model C
Upgrading the Optical (CD/DVD) Device 6 - 9
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4. Remove the screw at point , and use a screwdriver to carefully push out the 
optical device at point .

5. Reverse the process to install the new device.

Figure 6 - 8
Removing the 
Optical Device
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13

14

14

13

14
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Upgrading the System Memory (RAM)
The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-
DIMM) DDRIII (DDR3) type memory modules (see “Memory” on page D - 3 for
details of supported module types).

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws  -  (Models A & D) or 

 -  (Models B & C).

Figure 6 - 9
Component Bay 
Cover Screws

1 9
1 11

3
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2
Model B

Model BModels A & D
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3. Carefully remove the cover .
4. The RAM is located at point .

Contact Warning

Be careful not to touch
the metal pins on the
RAM module’s connect-
ing edge. Even the
cleanest hands have
oils which can attract
particles, and degrade
the module’s perfor-
mance.

Figure 6 - 10
RAM Location

12
13

Model BModels A & D
12 12

RAM Location
13 13

13RAM Location

Model C

12
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5. Gently pull the two release latches on the sides of the memory socket in the 
direction indicated by the arrows (  & ) in Figure 6 - 11.

6. The RAM module will  pop-up, and you can remove it.
7. Pull the latches to release the second module if necessary.
8. Insert a new module holding it at about a 30° angle and fit the connectors firmly 

into the memory slot.

9. The module’s pin alignment will allow it to only fit one way. Make sure the module 
is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit 
without much pressure.

10. Press the module in and down towards the mainboard until the slot levers click into 
place to secure the module.

Figure 6 - 11
RAM Module 

Removal


Single Memory 

Module Installation

If your computer has a
single memory module,
then insert the module
into the Channel 0
(JDIMM1) socket. In this
case this is the lower
memory socket (the
socket closest to the
mainboard).

14 15
16

14 15 16
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Chapter 7: Modules & Options
Overview
This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.

• Bluetooth Module
• PC Camera Module
• Wireless LAN Module
• Fingerprint Reader Module
• 3.75G/HSPA Module
• TV Tuner Module
• NVIDIA 3D Shutter Glasses Kit
• Setting Up SATA RAID or AHCI Modes


Wireless Device 

Operation Aboard   
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Important Notice

If your purchase option in-
cludes both Wireless LAN
and 3.75G/HSPA modules,
then the appropriate anten-
nas will be installed. Note
that In order to comply with
FCC RF exposure compli-
ance requirements, the an-
tenna must not be co-
located or operate in con-
junction with any other an-
tenna or transmitter.


Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module and the
Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and cause in-
terference. When the 3.75G/HSPA module is powered on, make sure that the Bluetooth/Wireless LAN
modules are powered off.
Overview 7 - 1
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Bluetooth Module
The operating system’s Bluetooth Devices control panel is used to configure the
Bluetooth settings in Windows Vista, and therefore does not require a driver. Use
the Fn + F12 key combination (see “Function/Hot Key Indicators” on page 1 -
12) to toggle power to the Bluetooth module. When the Bluetooth module is pow-
ered on, the  LED will be illuminated and the on-screen indicator will briefly be
displayed. If you are experiencing problems connecting to some Bluetooth devices
see “Bluetooth Connection Problems” on page 8 - 16.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see Table 1
- 6, on page 1 - 12/ Table 1
- 4, on page 1 - 9).


Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is sup-
ported in one direction only (simultaneous data transfer is not supported). Therefore
if you are copying a file from your computer to a Bluetooth enabled device, you will not be
able to copy a file from the Bluetooth enabled device to your computer until the file transfer
process from the computer has been completed.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
state. Use the key combination (Fn + F12) to power on the Bluetooth module after the com-
puter resumes from Sleep.
7 - 2 Bluetooth Module
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Bluetooth Configuration in Windows Vista

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module. 
2. A Bluetooth icon  will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the Bluetooth Devices control 

panel.

• Double-click the icon  to access the Bluetooth Devices control panel.
• Click Start, and click Control Panel (or point to Settings and click Control Panel), and then 

click Bluetooth Devices (Hardware and Sound).

• Click/Right-click the icon  and choose an option from the menu.


Bluetooth Taskbar 

Icon

If you cannot see the
Bluetooth icon in the task-
bar, access the Blue-
tooth Devices control
panel. Click Bluetooth
Settings > Options, and
make sure that Show the
Bluetooth icon in the
notification area check
box (Connections) has a
tick inside it.

Note that you will need to
check the LED indicator
to see if the module is
powered on or not.

Figure 7 - 1
Bluetooth Devices & 

Click Icon Menu

Bluetooth SettingsAdd Wireless Device
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To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel and click Bluetooth Settings.
2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to 

this computer check box (Connections) has a tick inside it, and click OK.
3. Click Add Wireless Device in the Bluetooth Devices control panel.
4. Double-click the device you want to pair with the computer.

5. On first connection the computer will provide you with a pairing code to be entered 
onto the device.


Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure 7 - 2
Pair with a wireless 

device
7 - 4 Bluetooth Module
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6. Enter the code into your Bluetooth enabled device and follow any on-screen 
instructions to complete the pairing.

7. Windows will check to see if any drivers are required to complete the pairing. 
8. Follow any on-screen instructions on the computer if device drivers are required to 

be installed.
9. Click Close.

Figure 7 - 3
Pairing Code 

Example

Figure 7 - 4
Pairing Complete & 
Bluetooth Device 

Enabled


Pairing Codes

The example outlined here shows a connection to
a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.
Bluetooth Module 7 - 5
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To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:

• Change the name of the device (click General, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Bluetooth Settings > Options, and make sure that Allow Bluetooth 

devices to find this computer check box (Discovery) has a tick inside it.
3. Make sure that the Alert me when a new Bluetooth device wants to connect 

check box (Connections) has a tick inside it, if you want to be notified when a 
Bluetooth device wants to connect.


Bluetooth Help

To get help on Bluetooth
configuration and set-
tings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box, and
select an item from the re-
turned search results to
get more information.

Figure 7 - 5
Bluetooth Settings - 

Options
7 - 6 Bluetooth Module
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PC Camera Module
If you have included a PC Camera module in your purchase option, make sure that
the PC Camera module is on before installing the driver. Use the Fn + F10 key com-
bination (see “Function/Hot Key Indicators” on page 1 - 12) to toggle power to
the PC Camera module. When the PC Camera module is powered on, the on-
screen indicator will briefly be displayed. Make sure you install the drivers in the
order indicated in Table 4 - 1, on page 4 - 3.

There are a number of different camera modules available with this computer model
series. You will have the appropriate application installed for your camera. Make
sure you access the application via the WebCam desktop shortcut.


Latest PC Camera 
Driver Information

Check the Device Driv-
ers & Utilities + User’s
Manual disc, and any
accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here.
PC Camera Module 7 - 7
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PC Camera Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Util-

ities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 1.PC Camera, Web cam > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish.
6. Run the camera application program from the shortcut on the desktop (if the 

hardware is turned off use the Fn + F10 key combination to turn it on 
again).


PC Camera Screen 

Refresh

If you find that the
screen refresh rate is
subject to lag or stutter-
ing, then reduce the
window size, or adjust
the Output Size and/or
Color Space Compres-
sion. 

To reduce Output Size
and/or Color Space
Compression run the
camera application,
click Options and select
Video Capture Pin. Ad-
just the settings from the
appropriate pull-down
menu.
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is 

not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
7. Click OK and close the control panels.
8. Run the camera application program from the desktop shortcut.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should 

have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick 

alongside it).
PC Camera Module 7 - 9
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Figure 7 - 6
Audio Setup for PC 

Camera

Right-click
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Camera Application
The WebCam application is a video viewer for general purpose video viewing and
testing, and for capturing video files to .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you 
set the capture file before the capture process - see “Set Capture File” on 
page 7 - 12).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page 7 - 9) and select Start Capture.

3. Click OK/Yes (the file location will be displayed in the pop-up box) to start 
capturing the video, and press Esc to stop the capture (you can view the file using 
the Windows Media Player).


Pre-Allocating File 

Size/Space

You may pre-allocate the
file size (File > Allocate
File Size/Space) for the
capture file in the camera
program (you may need
to set a folder location
first).

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

See also “Reducing Vid-
eo File Size” on page 7 -
13.
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Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and location before capture (this will help avoid ac-
cidentally overwriting files). Set the name and location then click Open, then set the
"Capture file size:" and click OK. You can then start the capture process as on the
previous page.

Note the important information in “Reducing Video File Size” on page 7 - 13 in
order to save file space, and help prevent system problems.
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Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows Vista system requires a minimum of 15GB of free space on
the C: drive system partition. In order to prevent system problems it is recommend-
ed that you save the captured video file to a location other than the C: drive (see “Set
Capture File” on page 7 - 12), limit the file size of the captured video (see “Pre-
Allocating File Size/Space” on page 7 - 11) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the camera application program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to 

reduce the captured file size.
4. Click OK.
PC Camera Module 7 - 13
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Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to
adjust the setting in the Video Capture Filter options.

1. Run the camera program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency/Powerline Frequency.

Figure 7 - 7
Video Capture Filter
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Zoom
The WebCam program allows you to zoom the camera in and out (note the zoom
function is not available in all camera model applications).

1. Run the camera application from the desktop shortcut.
2. Go to Zoom and select Zoom Out/Zoom In.

Taking Still Pictures
The WebCam program allows you to take still pictures.

1. Run the camera application from the desktop shortcut.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder  on the 

desktop.

Figure 7 - 8
Zoom/Setting


Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.
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Wireless LAN Module
If you have included an Intel® Wi-Fi Link Series or 3rd Party 802.11b/g/n WLAN
module in your purchase option, make sure that the Wireless LAN module is on be-
fore installing the driver.

Use the Fn + F11 key combination (see “Function/Hot Key Indicators” on page 1
- 12) to toggle power to the Wireless LAN module. When the WLAN module is
powered on, the  LED will be illuminated and the on-screen will briefly be dis-
played. Make sure you install the drivers in the order indicated in Table 4 - 1, on
page 4 - 3. 

Wireless should be turned ON in the Windows Mobility Center to ensure proper
wireless function key behavior (see “Wireless Hot Keys” on page 3 - 11).


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 6, on
page 1 - 12/ Table 1 - 4, on
page 1 - 9).
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Intel® Wi-Fi Link Series Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1. Make sure the module is powered on, then insert the Device Drivers & Util-
ities + User’s Manual disc into the CD/DVD drive. 

2. Click Option Drivers (button).
3. Click 2.Wireless Lan > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Next > Finish.

3rd Party 802.11b/g/n Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Util-

ities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Wireless Lan > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish to restart the computer.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows Vista (see overleaf).


Intel(R) PROSet/ 

Wireless

Access the Intel PRO-
Set Wireless tools (Sta-
tistics and Diagnostic
tools) from the Start
menu (Start > Pro-
grams/All Programs >
Intel PROSet). These
tools provide diagnostic
and statistical informa-
tion only (use the WLAN
control in Windows Vis-
ta to connect to a WLAN
access point).
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Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then click Connect to a network (or right-
click the icon , and then click Connect to a network).

2. In the Show list, click to choose Wireless from the drop-down menu.
3. A list of currently available networks will appear.

Figure 7 - 9
Taskbar Menus


Network and 

Sharing Center

You can also use the Net-
work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 10
Connect to a 

Network

Click icon Right-click icon
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4. Click a network, and then click Connect.
5. If you do not see a network you want to connect to, click Set up a connection or 

network (a list of options will appear allowing manual searching, and creating a 
new network).

6. Move the cursor over the taskbar icon  to see the connection status (see below).

Figure 7 - 11
Connecting

Figure 7 - 12
Connection Status
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7. To disconnect from the wireless network you can click the taskbar wireless icon , 
and then select Connect or disconnect to access the network menu, and click 
Disconnect (or right-click the icon , and then click Disconnect from).


Security Enabled 

Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure net-
works may allow unauthor-
ized access to your
computer, documents, web-
sites and files etc.

Figure 7 - 13
Disconnecting

Click icon

Right-click icon
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Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click Start, and click Control Panel (or point to Settings and click Control 
Panel).

2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon  to access the network 

menu.


Wireless Hot Keys

The computer’s wireless
function keys will not func-
tion properly if Wireless is
turned OFF in the Win-
dows Mobility Center
control panel.

The wireless indicators
 may show that

the WLAN module is pow-
ered on, however if wire-
less is OFF in the Mobility
Center, the module will not
be powered on. 

Make sure that Wireless is
ON in the Mobility Center to
ensure proper function key
behavior.

Figure 7 - 14
Windows Mobility 

CenterMake sure Wireless is ON to ensure proper function key behavior.
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Fingerprint Reader Module
The optional fingerprint reader provides a high level of security for your comput-
er. A further level of security and control is provided in the BIOS (see “Security
Menu” on page 5 - 10).

The fingerprint reader allows you to:

• Access or Lock your computer
• Protect sensitive files
• Display and file your favorite web pages
• Fill in frequently used dialogs
• Run your favorite applications

Install the driver as instructed below and configure the reader as outlined on the fol-
lowing pages.

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 3.FingerPrint > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.


Password Warning

If you set passwords for
any of the security mod-
ules, NEVER forget your
password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.


Help & Manual

Right-click the taskbar icon
 to bring up the menu to

select Help.

Insert the Device Drivers &
Utilities + User’s Manual
disc and click Option Driv-
ers (button). Click Unlock
(button) and then click
3.FingerPrint >Yes.

Click Documentation to
open the folder containing
the manual in .pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User’s Man-
ual disc and click User’s
Manual (button), and click
Install Acrobat Reader
(button).
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User Enrollment
1. Click Start > Programs/All Programs > Protector Suite > Control Center, or 

double click the taskbar icon  (click Initialize).
2. On the first run of the program you will be asked to click the Accept button to 

accept the license.
3. If you have not set a Windows password you will be prompted to do so (note: If 

you have not set a password Protector Suite cannot secure access to your 
computer).

4. Click Submit when you have entered password.
5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get 

help with fingerprint enrollment at any time).


Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 7 - 15
Fingerprint 
Enrollment

Tutorial
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6. Click the button above any of the fingers to begin the enrollment process for that 
finger.

7. Swipe the finger until the progress bar reaches 100% to enroll that finger.
8. Repeat the process for all the fingers you wish to enroll (see sidebar), and then 

click Save and Continue.
9. Enter a backup password and click Apply.
10. Close the fingerprint status window.


Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 7 - 16
Fingerprint Status
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11. Right-click the taskbar icon  and select Start Control Center (and then swipe a 
finger) to allow you to Edit Fingerprints, register Applications, edit Settings and 
access the Help menu etc. You can also run the Control Center etc. from the 
Protector Suite item in the Programs/All Programs menu

12. Click “Help” in Control Center Home to get more information on any topic.
13. You can also run the Tutorial, or Product Tour video to get more information.

14. See “Help & Manual” on page 7 - 22 for further details.
15. If you swipe your finger over the reader at any time you can access the Biomenu 

to lock the computer, register websites, access the Personal Safe, E-Wallet or 
Strong Password Generator, open the Control Center and access the Help 
menu.

Help

Figure 7 - 17
Control Center & 

Biomenu 
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Fingerprint Control Center Features

Application Launcher
The Application Launcher allows you to register applications to be launched when
assigned to a particular finger. Simply copy the application icon on to one of the reg-
istered fingers and ten click OK to close the application window. Once registered the
application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other set-
tings for web sites etc. 

Strong Password Generator
Strong Password Generator helps you to create complicated passwords resistant
to dictionary attacks from the Internet.

E-Wallet
The E-Wallet provides biometric security for important personal information such
as credit card details, account numbers etc.

File Safe
File Safe is an encrypted area assigned on your hard drive that allows you to store
files and folders to be protected by fingerprint protection.


Help 

For more information on
these and other features
simply access “Help” in
the Fingerprint Control
Center and select the
item from the menu on
the left.
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3.75G/HSPA Module
(Optional for Model A & D Computers Only)
If you have included an optional 3.75G/HSPA (High Speed Packet Access) module
(see “Communication” on page D - 6 for specification details) in your purchase op-
tion, you will have the appropriate application (HSPA Modem Interface or Mobile
Partner) provided for your module. Follow the instructions on page 7 - 29 to install
the USIM card (supplied by your service provider), and then install the application
(see over for further details).


3.75G/HSPA Module 

Options

There are two optional
3.75G/HSPA modules
available for this series of
computer models. Each
module is supplied with the
appropriate application
software.

The module type supplied
may depend upon the com-
puter model purchased.
Check with your service
center for details.

Install the driver from the
Drivers Installer menu and
check the instructions for
the appropriate application
on the following pages.


Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module
and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio fre-
quency, and cause interference. When the 3.75G/HSPA module is powered on, make sure
that the Bluetooth/Wireless LAN modules are powered off.
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Before installing the application, make sure that the 3.75G/HSPA module is ON
(installing the driver with the module off will not allow the software to detect the
module hardware correctly). Use the Fn +  key combination (see “Function/Hot
Key Indicators” on page 1 - 12) to toggle power to the 3.75G/HSPA module.
When the 3.75G/HSPA module is powered on, the on-screen indicator will briefly be
displayed. Make sure you install the drivers in the order indicated in Table 4 - 1, on
page 4 - 3. Note that exiting the application does NOT turn off the 3.75G/HSPA
module.

• HSPA Modem Interface - See “HSPA Modem Interface Installation” on 
page 7 - 31 for driver installation information and “HSPA Modem Interface” 
on page 7 - 32 for instructions on using the HSPA Modem Interface.

• Mobile Partner - See “Mobile Partner Application Installation” on page 7 - 
40 for driver installation information and “Mobile Partner Application” on 
page 7 - 41 for instructions on using the Mobile Partner application.


3.75G/HSPA 

Modules & System 
Wake Up

Note that the 3.75G mod-
ules DO NOT support
system wake up on
3.75G/HSPA modem ac-
tivity.
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USIM Card Installation
1. Turn off the computer, and turn it over and remove the battery (see “Removing 

the Battery” on page 6 - 3).
2. The SIMLOCK is located in the compartment under the battery.
3. Remove screw  from the SIMLOCK cover, and remove the cover.
4. Insert the USIM card as you would into your mobile phone.


Power Safety 

Warning

Before you undertake
any installation proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Figure 7 - 18
Battery & SIMLOCK 

Cover Removal

1

Model A

SIMLOCK Location

1
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5. Slide the SIMLOCK towards the hinge (in the direction of the arrow illustrated in 
Figure 7 - 19) in order to release the lock and lift it up.

6. Insert the USIM card as illustrated in (Figure 7 - 20) and close the SIMLOCK.

7. Lock the SIMLOCK by pushing it in the direction of the arrow in Figure 7 - 20 until 
it clicks into the lock position.

8. Replace the cover, screw and battery.

Figure 7 - 19
Unlock the 
SIMLOCK

Figure 7 - 20
SIMLOCK Lock

Model A

A
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HSPA Modem Interface
With the 3.75G/HSPA module and USIM card (supplied by your service provider)
installed you may then install the HSPA Modem Interface. The HSPA Modem In-
terface allows you to directly access your HSPA internet service from the computer.

HSPA Modem Interface Installation

1. Enable power to the module by pressing the Fn +  key combination (the 
on-screen indicator will indicate the module’s power status). If a Found 
New Hardware window appears, click Cancel in all windows that appear, 
and then proceed to install the driver as below.

2. Click Option Drivers (button).
3. Click 4.3.5 Generation Module > Yes.
4. Click Next > Install.
5. Click Finish to restart the computer.
6. Access the HSPA Modem Interface from the Start menu (Start > Pro-

grams/All Programs > HSPA modem), or by double-clicking the HSPA 
modem icon on the desktop.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn +  key com-
bination to toggle power to
the 3.75G/HSPA module,
and check the indicator to
see if the module is pow-
ered on or not (see Table 1
- 6, on page 1 - 12/ Table 1
- 4, on page 1 - 9).
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HSPA Modem Interface
The connection information is stored on the USIM card supplied by the service pro-
vider.

1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by double-clicking the desktop 
icon .

3. If a USIM card is not installed then a message will appear to notify you of this (click 
OK to close the message and install the USIM card).

4. If you are required to enter a pin # then a message will appear to prompt you to 
enter a pin #. (Note: to change pin # go to Settings  and click OK in PIN 
code.)

5. Click the Network connection  button and the HSPA Modem interface 
window will display Connection Manager.


HSPA Modem Help

To get help on 3.75G/
HSPA module configu-
ration and settings, click
the help icon  and
select Help.

Figure 7 - 21
HSPA Modem 

Interface Window


Connection Manager

The connection information is commonly stored on the USIM
card supplied by the service provider. However if your ser-
vice provider requires details such as IP Address, User-
name and Password etc. to be entered before connection
you can enter them in the Connection Manager tab, or
save the details in Profiles.
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6. Click Connect  to connect to your service provider.

7. The message “Network is connected” will be displayed when the network 
connection is successful. 

8. You can then access the internet, download e-mail etc. as per any internet 
connection.

Figure 7 - 22
Connecting to 

Network

Figure 7 - 23
Network is 
Connected
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9. While you are connected the upper right corner of the HSPA Modem interface will 
display the upload and download rates, and the taskbar icon will display the 
connection speed.

10. To disconnect click the Disconnect  icon (Connection Manager).
11. The program will disconnect from the service provider.
12. The module will still be on, and you will need to press the Fn +  key combination 

to turn it off.

Adding a Profile
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click the Network connection , and click Profiles (tab).

Figure 7 - 24
Uploading/

Downloading Rates 
and Speed

Figure 7 - 25
Profiles
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3. Click Add (button) and input any Network Settings required by your service 
provider.

4. Click OK to save the profile.

5. You can Edit or Delete profiles from the Profiles tab.
6. To use a profile click to select it, and then click Apply (button) and the settings will 

be transferred to Connection Manager.

Figure 7 - 26
Network Settings & 

Profiles
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Contacts
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Contacts  (button).

3. Click Refresh (button) to download the contacts from the USIM card to the 
computer.

4. The Contacts will then be displayed.
5. Double-click any contact to edit the information (or right-click and select Edit).
6. You can also Export/Import contacts by clicking the appropriate button.

Figure 7 - 27
Network Settings & 

Profiles
7 - 36 3.75G/HSPA Module



Modules & Options

7

Messages
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Messages  (button).

3. Click Refresh (button) to download the messages from the USIM card to the 
computer.

4. Click New (button) to create a new message.
5. You can either type the telephone number in the recipient field, or press To 

(button) to select the contact from the list.


SMS Service

In addition to standard in-
ternet services you may
also send and receive
SMS text messages us-
ing the HSPA Modem In-
terface, if your service
supports SMS.

Figure 7 - 28
Network Settings & 

Profiles
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6. Click to select a contact from the list and then click Add (button) and the phone 
number will automatically be added to the recipient field.

7. Type the message information into the message body and click Send (button) to 
send it, or Save to draft (button) to save the message.

8. Select any message to forward or delete it, or to reply to it.

Settings
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Settings  (button).

Figure 7 - 29
Settings
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3. Click OK alongside any of the options to configure the settings.
4. The Network can be configured for an Automatic (usually from the USIM card) or 

Manual connection.
5. The Network Mode can be configured for any appropriate mode required.

6. You can also change your settings for the Pin #, and input your phone number.
7. Exiting the program DOES NOT turn off the 3.75G/HSPA module, and you will 

need to press the Fn +  key combination to turn off the module (pay careful 
attention to this aboard aircraft - see “Wireless Device Operation Aboard 
Aircraft” on page 7 - 16).

8. If the module is on and the computer enters a power-saving state, then the power 
status of the module on resuming from the power-saving state will be as below:

• If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted; 
the module will be off when the computer starts up.

• If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate; 
the module will be off when the computer resumes from sleep.

Figure 7 - 30 
Settings - Network/

Network Mode
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Mobile Partner
With the 3.75G/HSPA module and USIM card (supplied by your service provider)
installed you may then install the Mobile Partner application. The Mobile Partner
application allows you to directly access your HSPA internet service from the com-
puter.

Mobile Partner Application Installation

1. Enable power to the module by pressing the Fn +  key combination (the 
on-screen indicator will indicate the module’s power status). If a Found 
New Hardware window appears, click Cancel in all windows that appear, 
and then proceed to install the driver as below.Insert the Device Drivers & 
Utilities + User’s Manual disc into the CD/DVD drive.

2. Click Option Drivers (button).
3. Click 4.3.5 Generation Module > Yes.
4. Choose the language you prefer and click OK.
5. Click I Agree (button) to accept the license agreement.
6. Click Next > Install.
7. Click Finish to restart the computer.
8. Access the Mobile Partner application from the Start menu (Start > Pro-

grams/All Programs > Mobile Partner), or by double-clicking the Mobile 
Partner icon on the desktop.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn +  key com-
bination to toggle power to
the 3.75G/HSPA module,
and check the indicator to
see if the module is pow-
ered on or not (see Table 1
- 6, on page 1 - 12/ Table 1
- 4, on page 1 - 9).
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Mobile Partner Application
You will need to contact your service provider to obtain the exact details of how ex-
actly to configure the settings on this page.

Profile Management
1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the Mobile Partner application from the Start menu (Start > Programs/

All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon 
on the desktop .

3. If you have not created a profile, click Tools and select Options, and then click 
Profile Management.

4. Click New  and input the appropriate information for Profile Name, APN 
and Authentication etc. as supplied by your service provider.

5. Click Save  to save the profile.


Mobile Partner Help

To get help on Mobile
Partner configuration
and settings, click the
Help menu and select
Online Help or press
F1.

Figure 7 - 31
Profile Management
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Connecting to the Service Provider
1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the Mobile Partner application from the Start menu (Start > Programs/

All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon 
on the desktop .

3. The software will run and you can select the Profile Name from the menu.
4. Click Connect  to begin the connection process.

5. The Mobile Partner application will then display the connection information.

Figure 7 - 32 
Connect

Figure 7 - 33
Network 

Connection Prompt
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6. When the connection is successful you can move the cursor over the network icon 
in the taskbar to display the connection information.

7. You can then access the internet, download e-mail etc. as per any internet 
connection.

8. While you are connected the indicators in the Mobile Partner window will display 
uploading and downloading icons and a network icon in the taskbar .

9. To disconnect click the Disconnect  icon, or right click the taskbar icon 
and select Disconnect.

10. The program will disconnect from the service provider.

Figure 7 - 34
Connected 

Taskbar 
Notification

Figure 7 - 35
Disconnect
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11. The module will still be on, and you will need to press the Fn +  key combination 
to turn it off.

12. If you click the Mobile Partner close icon  a message will be displayed asking 
you to click OK to confirm the program exit and to terminate the connection. 

13. Exiting the program terminates the connection, but DOES NOT turn off the 3.75G/
HSPA module, and you will need to press the Fn +  key combination to turn off 
the module (pay careful attention to this aboard aircraft - see “Wireless Device 
Operation Aboard Aircraft” on page 7 - 40).

14. If the module is on and the computer enters a power-saving state, then the power 
status of the module on resuming from the power-saving state will be as below:

• If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted; 
the module will be off when the computer starts up.

• If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate; 
the module will be off when the computer resumes from sleep.

Figure 7 - 36
Exit Prompt
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TV Tuner Module
(Optional for Model B & C Computers Only)
If your purchase configuration includes the optional Hybrid (Analog & Digital)
USB Mini-Card TV Tuner module, you will be supplied with a remote control unit
and appropriate antenna and fittings for the module. Software support for the TV
Tuner module is provided by Windows Media Center in Windows Vista (Home
Premium Edition & Ultimate Edition) and in Windows 7 (not included in Starter
or Home Basic versions). In addition a driver is provided on the Device Drivers &
Utilities + User’s Manual disc for the remote control supplied with the TV Tuner.

The optional TV Tuner allows you to watch TV, play music CDs, video conference
and capture still images and video on your PC.

The Cable (CATV) antenna will only be enabled when a TV Tuner module is
installed. Make sure you connect the TV antenna.


TV Antenna

The TV antenna sup-
plied with any TV Tuner
module is intended for
indoor use only. Please
do not use your TV Tun-
er module outdoors.

TV Tuner Remote

Point the remote at the
consumer IR transceiv-
er to change channels
etc.

Figure 7 - 37
TV Tuner Ports/

Jacks

1. Consumer Infra-
red Transceiver

2. CATV Antenna 
Jack

2

1
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Consumer Infrared Driver
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 5.Install CIR Driver > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.

Windows Media Center
1. This TV Tuner module is fully supported by Windows Media Center in 

Windows Vista (Home Premium Edition & Ultimate Edition).
2. Run Windows Media Center directly from the Start menu (Start > Pro-

grams > Windows Media Center).
3. Windows Help and Support provides information on the Windows Media 

Center functions. Click Start  and select Help and Support, and then 
type “Media Center” in the Search Help box and click the magnifying 
glass icon  to bring up the results.


TV Tuner Module 

Support

Note that the TV Tuner
module (factory) option in
Windows is supported by
the Windows Media Cen-
ter software which comes
built-in to the Windows
Vista Home Premium and
Ultimate Editions only. 

If your purchase includes a
TV Tuner option, and you
are re-configuring your sys-
tem for a different system,
you should install either
Home Premium or Ulti-
mate Editions of Windows
Vista only. Note that Win-
dows Media Center is not
included in Starter or
Home Basic versions of
Windows 7.
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Digital TV Broadcast Signal
The antenna is the most crucial factor in receiving a clear digital terrestrial TV
broadcast signal. The passive antenna provided should provide a clear signal when
placed beside a window. If the signal is not clear then you can purchase an active
antenna (it should also be placed beside a window) to improve the signal. You
should also check with any related government website which provides information
on digital terrestrial TV coverage for your area. Note that (unlike standard analog
TV) if the digital signal is weak then no picture will appear on the TV at all.

TV Recording and Power Plans
If you intend to use the optional TV Tuner to record live TV, then go to the Power
Options control panel and create a power plan (see “Power Plans” on page 3 - 4)
to prevent the power saving options from adjusting the computer’s performance lev-
el.

Remote Control Unit
The remote control unit allows you to remotely start and send the system into a pow-
er saving state, to run Windows Media Center and to navigate the Media Center
menus etc. The remote control unit also gives full control over all TV and video
functions.


CATV Cable Safety

Make sure that your
CATV system installer
has connected the Co-
axial cable shield to the
grounding system of the
building, as close to the
point of cable entry as
practical.

This reminder is provid-
ed to call the CATV sys-
tem installer’s attention
to Article 820-93 of the
NEC (Section 54, Part I
of the Canadian Electri-
cal Code).
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NVIDIA 3D Shutter Glasses Kit
(for Model D Computers Only)
The NVIDIA 3DVISION shutter glasses kit is supported only by Model D comput-
ers with a 15.6" HD 120Hz panel and GTX 285M and GTS 360M video card. Install
the video driver as indicated in “NVIDIA Video” on page 4 - 6. 

The NVIDIA 3DVISION shutter glasses kit is supplied with a single pair of shutter
glasses, the external IR emitter and all necessary cables etc. A further set of shutter
glasses are offered as an option for Model D computers. Set up the hardware (plug
in the emitter after running the set up wizard as indicated overleaf) as instructed in
the manual supplied with the kit, however make sure you have installed the NVID-
IA driver (see “NVIDIA Video” on page 4 - 6) from the Device Drivers & Utilities
+ User’s Manual disc and not from the discs provided in the kit. For further details
contact your service center.


NVIDIA Driver

Install the NVIDIA driv-
er (see “NVIDIA Video”
on page 4 - 6) from the
Device Drivers & Utili-
ties + User’s Manual
disc (to ensure compat-
ibility) and not the driv-
ers provided with the kit.

You can install the utili-
ties and demonstration
programs provided with
the kit. 


Important Safety Instructions

Make sure you read all the enclosed safety instructions and precautions included in the NVIDIA 3D
Vision Kit before setting up the 3D Glasses and IR Emitter. Follow the setup instructions provided in
the documentation to set up the 3D Vision kit safely and take the “User Vision Test,” which will initiate
when you turn on your GeForce 3D Vision for the first time. If you cannot see the image in 3D during
the test, you should DISCONTINUE USE IMMEDIATELY. Continued use may result in health-related
complications.
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Set Up Stereoscopic 3D 
After the NVIDIA driver has been installed you can setup NVIDIA 3D Vision. 

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the 

menu if you are in Control Panel Home).
3. Double-click Stereoscopic 3D (if the sub-menus are not visible), and then click

Set Stereoscopic 3D.
4. Click Enable stereoscopic 3D (tickbox) to run the setup wizard.
5. Follow the on-screen instructions to set up 3D Vision (insert the IR emitter’s USB 

cable when prompted) and click “Next” to progress through the steps.


NVIDIA Control 

Panel 

To access the Ge-
Force..... control panel
from the desktop; right-
click the desktop, then
click NVIDIA Control
Panel.

Figure 7 - 38
NVIDIA Control 

Panel Run Setup 

Wizard

Enable stereoscopic 3D
NVIDIA 3D Shutter Glasses Kit 7 - 49



Modules & Options

7

6. Configure the Stereoscopic 3D from the control panels.
7. Click View Compatibility With Games to check 3D support for any games (click 

the “Show only installed games” tickbox to view only the games installed on the 
computer).

Figure 7 - 39
Compatibility With 

Games

Show only installed games
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8. You can enable/disable stereoscopic 3D by clicking the tickbox provided.
9. The dropbox under Test stereoscopic 3D allows you to rerun the setup wizard or 

medical image test at any time.
10. The stereoscopic depth may be adjusted by using the control panel slider or the 

wheel on the emitter.

Figure 7 - 40
Stereoscopic 3D
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Setting Up SATA RAID or AHCI Modes
(RAID Mode is Optional for Model B & C Computers Only)

AHCI Mode
Advanced Host Controller Interface (AHCI) is an interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance). AHCI mode can be
supported by one, two or three hard disks.

RAID (Models B & C Only)
You may use your hard disks (if you have included more than one hard disk in your
purchase option) in combination with Striping (RAID 0) or Mirroring (RAID 1) for
either fault tolerance or performance (see Table 7 - 1, on page 7 - 53). To configure
your system in Striping (RAID 0) or Mirroring (RAID 1) modes you will require two
hard disks installed.

Intel® Matrix Storage Manager
Make sure you install the Intel Matrix driver and application if you have set up your
hard disk(s) in RAID modes (see “Intel Matrix Driver Installation” on page 7 -
57).


RAID Hard Disks

All hard disks in a RAID
should be identical (the
same size and brand) in
order to prevent unex-
pected system behavior.
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Prepare the following before setting up your serial ATA hard disks in RAID mode
(to configure AHCI mode you do not need to prepare any extra hard disks but will
need to install the Intel Matrix driver):

1. The Microsoft Windows OS CD.
2. A second (identical) hard disk installed in the secondary HDD bay for RAID level 

0 or 1 (required for RAID but not required for AHCI).
3. The Device Drivers & Utilities + User’s Manual disc.

RAID Level Description

RAID 0
Identical drives reading and writing data in parallel to increase performance. RAID 0 
implements a striped disk array and the data is broken into blocks and each block is 
written to a separate disk drive.

RAID 1

Identical drives in a mirrored configuration used to protect data. Should a drive that is 
part of a mirrored array fail, the mirrored drive (which contains identical data) will 
handle all the data. When a new replacement drive is installed, data to the new drive is 
rebuilt from the mirrored drive to restore fault tolerance.

Table 7 - 1
RAID Levels


Array Types

A Mirrored Array
(RAID 1) provides full
data protection, as
data can simply be
copied from a healthy
disk to a replacement
for any failed disk.

A Striped Array
(RAID 0) is NOT fault-
tolerant. The failure of
one drive will result in
the loss of all data in
the array. It is de-
signed to increase disk
performance by
spreading the I/O load
across the channels
and drives.
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SATA RAID Setup Procedure (BIOS)
1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select "SATA Mode Selection" and press Enter (see 

page 5 - 8).

• Select “RAID”.

3. Press Esc and go to the Boot menu.
4. Set the CD/DVD-ROM Drive (make sure the Microsoft Windows OS CD is

inserted) as the first device in the boot order from the Boot menu.
5. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and

press Enter to exit the BIOS and reboot the computer.
6. For RAID mode see the instructions in “RAID Setup (Intel Matrix)” on page 7 - 55.


RAID and Ready-

Drive Compatibility

On a system configured
in RAID mode, a condi-
tion exists where NV
Cache commands will
not be sent to the Win-
dows ReadyDrive*
cache provided by In-
tel® Turbo Memory. 

Microsoft has released a
Knowledge Base article
and QFE that addresses
this issue. (http://sup-
port.microsoft.com/
kb/954943).

Intel recommends that
customers who encoun-
ter this issue directly
contact Microsoft to ob-
tain the QFE.
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RAID Setup (Intel Matrix)
1. Press Ctrl + i to enter RAID configuration menu.

2. Select 1.Create RAID Volume and press Enter.
3. Type the RAID volume name and then press Tab or Enter to advance to the next 

field.
4. Specify (use the up and down arrow keys) the RAID level (RAID 0 or RAID 1 see 

Table 7 - 1, on page 7 - 53) and then press Tab or Enter to advance to the next 
field.

5. Press Enter and the system will select the physical disks to use.
6. Press Enter and select (if applicable) the Strip Size (best set to default).
7. Press Enter and select the Capacity size (best set to default).
8. Press Enter to select Create Volume.
9. Press Enter to create the volume, and confirm the selection by pressing Y.

Figure 7 - 41
Intel(R) Matrix 

Storage Manager 
Option ROM
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10. This will now return to the main menu.

11. Select 6.Exit and press Enter, then press Y to exit the RAID configuration menu.
12. As the computer starts up, press a key when you see the message "Press any 

key to boot from CD".
13. Press Enter to continue installing the operating system as normal (see your 

Windows documentation if you need help on installing the Windows OS).
14. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual 

disc as per Table 4 - 1, on page 4 - 3.
15. After installing all the necessary system drivers you need to install the Intel Matrix 

driver (see “Intel Matrix Driver Installation” on page 7 - 57).

Figure 7 - 42
RAID Created
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Intel Matrix Driver Installation
1. Make sure you have installed all the necessary drivers from the Drivers Installer 

menu (see Figure 4 - 2 on page 4 - 2).
2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive

of the operable computer and click Browse CD/DVD.
3. Navigate (Browse...) to D:\Others\and double-click the iMXM\iata_cd file.
4. Click Next > Next > Yes > Next > Next.
5. Click Finish to restart the computer.

Intel® Matrix Storage Manager
The Intel Matrix Storage Console displays status information on your RAID con-
figuration. Run the Intel® Matrix Storage Console from the Intel® Matrix Stor-
age Manager in the Programs/All Programs menu. The Intel® Matrix Storage
Manager provides information on the RAID status.


e-SATA Port

Install the Intel Matrix
Storage driver to dis-
play the safe removal
icon for e-SATA devices
in the taskbar 

Figure 7 - 43
Intel Matrix Storage 

Console
(Basic & Advanced 

Views)
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If a hard drive member of a RAID volume is reported as “Degraded” or “Failed” it
may be possible to recover the volume. If the volume cannot be restored then you
will need to recreate the RAID volume and restore the data from a back up. The Help
menu (press F1 or select Contents and Index from the Help menu) provides in-
structions on how to recover or recreate RAID Volumes.

Figure 7 - 44
Intel Matrix Storage 

Manager Help
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RAID Volume Data Verification and Repair
The RAID volume data verification process identifies any inconsistencies or bad
data on a RAID 0, RAID 1 or Recovery volume. The table outlines what occurs for
each RAID level:

See over for details on how to verify and repair RAID volume data.

Replacing and Reverting Recovery and Master Volumes
If a master or recovery drive fails you will need to add a new identical drive and re-
build the recovery volume to the drive. You can also revert the master drive to the
state of the previous volume update. For details on how to do this see “Intel Matrix
Storage Manager Help” on page 7 - 58.

RAID 
Level

Verify Verify & Repair

RAID 0 Bad blocks are identified. N/A

RAID 1

Bad blocks are identified.

Data on the mirrored drive is compared to 
data on the source drive.

Bad blocks are reassigned.

If the data on the mirrored drive does not 
match the data on the source drive, the 
data on the mirrored drive is overwritten by 
the data on the source.

Table 7 - 2
RAID Verification & 

Repair Status
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Verifying and Repairing RAID Volume Data
1. Run the Intel® Matrix Storage Console from the Intel® Matrix Storage Man-

ager in the Programs/All Programs menu.
2. Click View > Advanced Mode.
3. Right-click on the RAID volume and select either Verify Volume Data or Verify 

and Repair Volume Data.

4. The verification or verification and repair process will run and display progress.
5. A dialog box will display the final status of the verification or verification and repair 

status.

Figure 7 - 45
RAID Verification 

(Intel® Matrix 
Storage Console)

Figure 7 - 46
Verification Status
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Chapter 8: Troubleshooting

Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 8 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indica-
tors” on page 1 - 9) to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Power-Saving States” on page 3 - 6), the Fn + F4 key combination, or 
power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
(this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / 
“Remove disks or other media. Press any key to restart”).
8 - 2 Basic Hints and Tips
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Supervisor password for the BIOS (see “Security Menu” on page 5 - 10).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).


Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
Backup and General Maintenance 8 - 3
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
8 - 4 Viruses
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).
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• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and 
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
8 - 6 Upgrading and Adding New Hardware/Software
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn’t
work.

Battery missing / incorrectly installed. Check the battery bay, make sure the
battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator , is
blinking orange.

Low Battery. Plug in the power source. If the computer doesn’t start up
immediately, turn it off then on again.

You are losing battery power too quickly. The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 4) check its settings. You may also be using
an ExpressCard/USB device/external device that is drawing a lot of power.

Actual battery operating time is shorter
than expected.

The battery has not been fully discharged before being recharged. Make sure
the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 10).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/USB device/ExpressCard is consuming a lot of power. Turn
off/remove the unused device to save power.
Problems and Possible Solutions 8 - 7
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The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see
“Overheating” on page 1 - 16). Make sure you’re using the correct adapter. 

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 8).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you’re connected to an external monitor, make sure
it’s plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external
monitor I have plugged in and powered
on.

You haven’t installed the video driver and configured it appropriately from the
Control Panel. See Appendix B for instructions on installing and configuring
the video driver.

Problem Possible Cause - Solution
8 - 8 Problems and Possible Solutions
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You forget the boot password. If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows taskbar, or use the key combination Fn + F5 and
F6 (see “Function/Hot Key Indicators” on page 1 - 12) to adjust.

The CD/DVD cannot be read. The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will not open when
there is a disc in the tray.

The CD/DVD is not correctly placed in the tray. Gently try to remove the disc
using the eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes can no longer
be changed.

The code has been changed the maximum 5 times. See “DVD Regional
Codes” on page 2 - 5.

Unwelcome numbers appear when
typing.

If the LED  is lit, then Num Lock is turned ON. (see “LED Indicators” on
page 1 - 9).

Problem Possible Cause - Solution


Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
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The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 6). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN/Bluetooth/3.5G
modules cannot be detected.

The modules are off. Check the LED indicator and/or function key indicator to
see if the WLAN/Bluetooth/3.75G/HSPA module is on or off (see “LED
Indicators” on page 1 - 9). If the LED indicator is off, then press the Fn + F11
(WLAN), Fn + F12 (Bluetooth) or Fn +  (3.75G) key combination(s) in order
to enable the modules (see “Function/Hot Key Indicators” on page 1 - 12).

Problem Possible Cause - Solution


Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.
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The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 12). Run the camera
program from the desktop shortcut to view the camera picture.

The Wireless LAN/Bluetooth/ PC
Camera/3.75G/HSPA modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 7 - 1).

The Wireless LAN indicators 
show that the WLAN module is powered
on, however the module does not connect.

The WLAN module is turned off in the Windows Mobility Center. The
computer’s wireless function keys will not function properly if Wireless is turned
OFF in the Windows Mobility Center control panel. Make sure that Wireless is
ON in the Mobility Center to ensure proper function key behavior (see
“Wireless Hot Keys” on page 3 - 11).

A file cannot be copied to/from a
connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process from the computer has been
completed

The Bluetooth module is off after
resuming from Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep
power-saving state. Use the key combination (Fn + F12) to power on the
Bluetooth module after the computer resumes from Sleep.

Problem Possible Cause - Solution
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I am setting up the NVIDIA 3D Vision Kit
(Model D computers), and have taken
the “User Vision Test”, but I cannot see
the 3D image.

If you cannot see the image in 3D during the test, you should DISCONTINUE
USE IMMEDIATELY. Continued use may result in health-related complications.

The Hibernate function has disappeared. You have a computer with 4GB of RAM and have installed Windows Vista
Service Pack 1. This is a known issue if your computer has 4GB of RAM and is
running Windows Vista Service Pack 1. To re-enable Hibernate mode go to
the Command Prompt and type the command “powercfg -h on” (make sure
you are logged on as an Administrator):

1. Click Start  (menu button).
2. Type “cmd” in the Start Search box .
3. Double click the Command Prompt  when it appears in the 

menu.
4. Type “powercfg -h on” in the Command Prompt window.
5. Close the Command Prompt window.
6. The Hibernate function will now be enabled.

Problem Possible Cause - Solution
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The system is experiencing problems with
an attached e-SATA (external Serial
Advanced Technology Attachment) device.

Follow the instructions to install the Matrix Driver from the location indicated
below:

1. Insert the Device Drivers & Utilities + User’s Manual disc and 
click Browse CD/DVD. 

2. The driver is located in the following location on the disc: 
X:\Others\iMXM\iata_cd. 

3. Double-click the executable setup file and follow the on-screen 
instructions to install the driver.

Systems with NVIDIA GeForce GTS 360M
video cards experience display problems
(black screen or display abnormalities)
when resuming from a power-saving state.

This issue and can be resolved by installing the latest driver provided on the De-
vice Drivers & Utilities + User’s Manual disc.

1. Insert the Device Drivers & Utilities + User’s Manual disc.
2. Click Browse CD/DVD (button).
3. The driver is located in the following location on the disc: 

• 01. \Bata Driver\nv18895\vista64\ --> For 64bit Vista/Win7 
• 02. \Bata Driver\nv18895\vista32\ --> For 32bit Vista/Win7

4. Double-click the executable setup file and follow the on-screen 
instructions to install the driver.

Problem Possible Cause - Solution
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Screen Resolution Error
If you are experiencing either screen resolution reduction, or screen flickering after resuming from Sleep in
Windows Vista only then follow the instructions below to fix this problem. This error arises in compliance with
Windows Vista policy, which triggers TMM (Transient Multi-Monitor Manager) when the notebook lid (S3) is
closed. TMM disconnects the LCD display from the OS and then adds the LCD display back when the lid is
opened. This may trigger TMM to restore an old display setting which may result in screen flickering or a screen
resolution change. To fix this problem you will need to disable TMM in the OS:

1. Go to the Control Panel in the Windows OS and double-click the Administrative Tools icon (System and 
Maintenance).

2. Double-click Task Scheduler (Schedule Tasks).

Figure 8 - 1 - Control Panel System and Maintenance
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3. Double-click Task Scheduler Library > Microsoft > Windows.
4. Click MobilePC to open the control panel.
5. Right-click TMM and select Disable.

Figure 8 - 2 - TMM Disable

6. Close all the control panels.
Screen Resolution Error 8 - 15
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Bluetooth Connection Problems
If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and
headsets) it maybe necessary to download and install the Windows Mobile Device Center software (for Win-
dows Vista and Windows 7). Go to the Microsoft website and search for the Microsoft Windows Device Center
Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver. 

1. Install the Microsoft Windows Device Center Driver as appropriate for your operating system.
2. Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
3. Make sure the Bluetooth device is powered on.
4. Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and 

Printers).
5. Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have 

connected, or tried to connect to, a Bluetooth device previously).

Figure 8 - 3 - Device Manager


Bluetooth Peripheral Devices

You will need to repeat the procedure
listed here for all Bluetooth Peripher-
al Devices listed under Other Devices
i.e. until there are no more Bluetooth
Peripheral Devices listed under this
menu heading.
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6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.
7. Click Browse my computer for driver software.
8. Click Let Me pick from a list of device drivers on my computer.

Figure 8 - 4 - Browse my computer.../Let me pick from...

9. Select Bluetooth Radios from the list.

Figure 8 - 5 - Select Bluetooth Radios
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10. A list of drivers will appear with Manufacturer on one side and Model in the other. 
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not 

choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for 
Microsoft Corporation to appear in the list). 

12. Select Windows Mobile-based device support from the Model list.

Figure 8 - 6 - Select Device Driver

13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.

Make sure you select
Microsoft Corporation
8 - 18 Bluetooth Connection Problems
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15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth 
Radios.

16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

Figure 8 - 7 - Device Manager - Bluetooth Radio
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Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.

Item Description

Cable (CATV) 
Antenna Jack

Use this jack to connect a CATV cable if you have included the optional TV Tuner in your
purchase configuration for Model B & C computers only.

Card Reader Port The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device. The card reader allows you to use the following
digital storage cards:

MMC (MultiMedia Card) RS MMC (requires PC adapter)
SD (Secure Digital) Mini SD (requires PC adapter)
MS (Memory Stick) MS Duo (requires PC adapter)
MS (Memory Stick Pro)

Consumer Infrared 
Transceiver

The consumer infrared transceiver at the front of the computer allows the computer to
communicate with the remote control unit supplied with the optional TV Tuner for Model B & C
computers only.
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DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

DVI-Out Port The DVI-Out (Digital Visual Interface) Port (at the rear of the computer) allows you to connect an
external monitor, or Flat Panel Display, to allow dual video or simultaneous display on the LCD
and external monitor/FPD (see “Display Devices” on page B - 5). If you are using an older type
of monitor you will need to use a converter to convert the signal from DVI to VGA.

e-SATA Port Plug external Serial ATA hard drives into this e-SATA (external Serial Advanced Technology
Attachment) port.

HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals (see “HDMI Audio Configuration” on page B - 11).

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

Line-In Jack The Line-In jack allows you to play audio sources through the computer’s speakers. Note that
audio input through Line-in will default to the mute setting. To set up your audio sources to play
through the Line-in jack go to the Sound  control panel and make sure the Mute box is not
ticked.

Item Description
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Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

Mini-IEEE 1394 Port This allows high-speed connection to various peripheral devices, e.g. external disk drives and
digital cameras (see note below).

RJ-11 Phone Jack This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11
telephone connection.

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

Item Description


IEEE 1394

The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices. Make sure you
install the Firewire IEEE 1394 driver (see page 4 - 6).
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S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

USB 2.0/1.1 Ports

USB 3.0 Port

These USB (Universal Serial Bus) 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are
for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals
such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be
plugged into the computer, and unplugged from the computer, without the need to turn the system
off (if the power rating of your USB device is 500mA or above, make sure you use the power
supply which comes with the device).

Some models in this series have a single USB 3.0 port on the right side of the computer, other
models will have a USB 2.0 port. The USB 3.0 port is denoted by its blue color; USB 2.0 ports are
colored black. USB 3.0 will transfer data much faster than USB 2.0, and is backwards-compatible
with USB 2.0.

Note that the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7/.“USB 3.0”
on page E - 31).

Item Description
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Appendix B: NVIDIA Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 21.

NVIDIA Video Driver Installation
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.
Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers
(button).

1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes.
3. Click Finish to restart the computer.


Resolution Error

If you are experiencing
screen resolution prob-
lems/screen flickering after
resuming from Sleep in
Windows Vista see page
8 - 14.


Video Card Options

Note that card types, specifications and drivers are subject to continual updates and chang-
es. Check with your service center for the latest details on video cards supported.
NVIDIA Video Driver Installation B - 1
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NVIDIA Control Panel
More advanced video configuration options are provided in the NVIDIA Control
Panel tab.

1. Open the Display Settings (see page 1 - 22) control panel.
2. Click Advanced Settings (button).
3. Click GeForce..... (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments.

OR
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the

menu if you are in Control Panel Home).


NVIDIA Control 

Panel 

To access the Ge-
Force..... control panel
from the desktop; right-
click the desktop, then
click NVIDIA Control
Panel.

Figure B - 1
NVIDIA GeForce..... 

Control Panel
B - 2 NVIDIA Control Panel
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The NVIDIA Control Panel provides additional video configuration controls and
tools which allow quick access to features such as display configuration, 3D Settings
and Help menus etc.


Navigating the 
Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.
Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

Figure B - 2
NVIDIA Control 

Panels
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The Help menus provide index and search features, and direct links to the NVIDIA
website etc.

Figure B - 3
Help Menus
B - 4 NVIDIA Control Panel
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Display Devices
Note that you can use a DVI cable connected to the DVI-Out port, or an HDMI
(High-Definition Multimedia Interface) cable connected to the HDMI-Out port to
connect an external display (if you are using an older type of monitor you can use a
converter to convert the signal from DVI to VGA). See your display device manual
to see which formats are supported.

1. The built-in LCD.
2. An external display connected to the DVI-Out Port.
3. An external display/TV (if the TV supports an HDMI connection) connected to the

HDMI-Out Port.


Display Devices

Besides the built-in
LCD, you can also use
an external monitor/flat
panel display as your
display device. The dis-
play options are:

• The built-in LCD.
• An external display 

connected to the DVI-
Out port.

• An external display 
connected to the 
HDMI-Out port.

Note that HDMI sup-
ports video and audio
signals.

DO NOT use the Fn +
F7 key combination to
toggle through display
options when SLI is en-
abled.


Monitor and TV Tuner

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aeri-
al to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tun-
er first, then the monitor.
Display Devices B - 5
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Attaching Other Displays
Configuring an External Display in Windows Vista
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click on any of the buttons to configure the displays to your preferences, or click
Display Settings (in the New Display Detected window) to access the control
panel.

Figure B - 4
New Display 

Detected
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Configuring an External Display using the NVIDIA Control Panel
Alternatively you can use the NVIDIA control panel to configure any attached dis-
plays.

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page  B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up

multiple displays.
4. Any attached display will appear under “1.Select the displays you want to use.”

Figure B - 5
Set Up Multiple 

Displays
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5. Click the tickbox alongside any display you wish to use.
6. Click Apply > Yes to save the changes.
7. The default display mode will be in Extended mode (i.e the desktop will be

extended on to the external display - see “Display Devices” on page B - 5), and
you can use the built-in NVIDIA controls (“Enabling Clone Mode” on page B -
9) or New Display Detected (“Attaching Other Displays” on page B - 6)
window to configure the display.

8. If you prefer to use Clone mode see overleaf.


Display Not Shown

If the attached display
does not appear in the
“1.Select the displays
you want to use.” win-
dow, click “My Display
is not shown...” and
then click the appropri-
ate button to force de-
tection of the missing
display.

Figure B - 6
Select Display to 

Use
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Enabling Clone Mode
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page  B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up

multiple displays.
4. Any attached display will appear under “1.Select the displays you want to use.”
5. Click the tickbox alongside any display you wish to use.
6. Click Apply > Yes to save the changes.
7. The default display mode will be in Extended mode, to change to Clone Mode

right-click one of the display icons and click “Clone Laptop Display and....” (a tick
will appear alongside it) option from the pop-up menu and click Apply.

Figure B - 7
Enable Clone Mode
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8. To switch back to Extended Mode right-click one of the display icons and click
“Clone Laptop Display and....” (to remove the tick) option from the pop-up menu
and click Apply.

Figure B - 8
Switch to Extended 

Mode
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HDMI Audio Configuration
As HDMI (High-Definition Multimedia Interface) carries both audio and video sig-
nals you will need to configure the audio output as per the instructions below. The
settings will depend upon the video card you have installed in your purchase option.

Windows Audio Setup for HDMI
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Playback (tab), and click to select Realtek Digital Output.
4. Click Set Default (button).
5. Click OK to close the Sound  control panel.
6. You will now be able to hear audio sources when played in Windows Media Player.

Figure B - 9
Sound Playback 

Options
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7. Adjust the HDMI settings from the control panel tabs.
8. Click OK to close the Sound  control panel.

Figure B - 10
HDMI Device 

Properties
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HDMI Notes
• Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-

ing to play audio/video sources through the device.

• If you disconnect the HDMI cable the default audio playback device will not 
revert to speakers until the computer is restarted (if you do not wish to restart the 
computer then go to the Sound control panel and select Speakers as the default 
audio playback device).

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Configuring an

External Display using the NVIDIA Control Panel” on page B - 7.
3. Set up your external display (TV or LCD) for HDMI input (see your display device

manual).
4. You can now play video/audio sources through your external display.


 Other Applications

If you are using a third
party application to play
DVDs etc. you will need
to consult the applica-
tion’s documentation to
see the appropriate au-
dio configuration (the
application must support
digital to analog transla-
tion).


HDMI Audio Support

Note that some NVIDIA video card models DO NOT support High Definition Audio through
HDMI. When connecting these video cards to an external display (using an HDMI cable), it
is recommended that you use a third party video application (e.g. Power DVD) that provides
appropriate audio decoding to play DVDs etc. Alternatively you can output audio through
an alternative source to the HDMI connection.
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Display Modes
Single Display Mode
Only one of your displays is used.

Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on the other
display(s). This mode will drive multiple displays with the same content.

Dualview Mode
Dualview Mode (or Extended Mode in Windows Vista - see overleaf) treats both
connected displays as separate devices, and they act as a virtual desktop resulting in
a large workspace. When Dualview is enabled, you can drag any icons or windows
across to the other display desktop. It is therefore possible to have one program vis-
ible in one of the displays, and a different program visible in the other display.


SLI Configuration & 

Multiple Displays

Note that if SLI configu-
ration is enabled only a
Single display may be
used as the display de-
vice.

DO NOT use the Fn +
F7 key combination to
toggle through display
options when SLI is en-
abled. SLI supports only
a Single display, and at-
tempting to configure
dual displays may cause
an error. Use the NVID-
IA control panel to select
the display to be used.
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Using New Display Detected to Enable Extended Mode
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.

Figure B - 11
New Display 

Detected 

(Extended)
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Using Display Settings to Enable Extended Mode
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Click Start, and click Control Panel (or point to Settings and click Control

Panel).
3. Click Adjust screen resolution under the Appearance and Personalization

menu (or double-click Personalization > Display Settings).
4. Click the monitor icon (e.g. ), and make sure you have checked “Extend the

desktop onto this monitor.” and click Apply.


 Display Settings 

Extended Desktop 

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use.

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure B - 12
Display Settings 

(Extend the 

Desktop)

2

Click the appropriate monitor
icon (e.g. ) to be able to select
the option to extend the desktop
on to it.

In this example the Primary mon-
itor  is on the left, the secondary
display  is on the right.

2

1

2
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Enabling TV Display
To display desktop images on a TV, connect the TV to your computer by using an
HDMI cable/DVI cable from the TV to the HDMI-Out port/DVI-Out port (if sup-
ported by your TV).

1. You will need to enable the TV display from the NVIDIA Control Panel as per the 
instructions on page B - 7. The TV will appear as a display option (“1.Select the 
displays you want to use.”) when attached to the appropriate port. 

2. Apply the settings, and then click Yes to save the changes.
3. The settings for TV and Video may be adjusted using the sub-menus under Video

& Television.


Detect Displays

To get a full range of dis-
play options click “My
Display is not
shown...”

HDMI Audio Setup

See “HDMI Audio Con-
figuration” on page B -
11 for instructions on
configuring audio for
HDMI display devices. 

Set up your external dis-
play (TV or LCD) for
HDMI input (see your
display device manual).

Figure B - 13
Video & Television
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Changing the TV Signal or HD Format
1. When the TV is enabled as a display device click the sub-menus under Video & 

Television.
2. Click “Select the format you would like to use.”.
3. Select the TV signal format you would like to use.
4. Apply the settings, and then click Yes to save the changes.

Figure B - 14
Change the Signal or 

HD Format
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Appendix C: ATI Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 21.

ATI Video Driver Installation
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.
Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers
(button).

1. Click 2.Install Video Driver > Yes.
2. Click Next > Install (button).
3. Click the Express (or Custom if you prefer to manually configure the 

driver installation settings) button and click Next.
4. Click Accept (button) and click Yes.
5. Click Finish > Yes to restart the computer.

Note: After installing the video driver go to the Display/Display Settings control
panel to adjust the video settings to the highest resolution.


Video Card 

Options

Note that card types,
specifications and driv-
ers are subject to con-
tinual updates and
changes. Check with
your service center for
the latest details on
video cards supported.
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ATI Catalyst® Control Center
Adjust the video settings from the ATI Catalyst® Control Center.

1. Open the ATI Catalyst Control Center (see page 1 - 21).
2. Click Advanced (button).
3. A wizard will help you set up the display options, or you can click Advanced

(button) to go to the ATI Catalyst Control Center (you can change the options
from the Basic menu or the View menu in the ATI Catalyst Control Center).

4. Note that the Advanced options are featured in this chapter (if you choose Basic
the on-screen Wizard will help you configure your display options)


ATI Taskbar Icon

The ATI Catalyst Control
Center can be accessed as
above or by double-clicking
the icon  in the taskbar
(or by right-clicking the icon
and selecting Catalyst
Control Center).

If you don’t see the ATI icon
in the taskbar, click Op-
tions > Preferences (tab)
in the ATI Catalyst® Con-
trol Center, and select En-
able System Tray Menu
(see Figure 1 - 12 on page
1 - 22).

Right-click the ATI icon 
to bring up the taskbar
menu.

Figure C - 1
ATI Catalyst Control 

Center Basic Settings

Click Advanced Button to go to
the ATI Catalyst Control Cen-
ter. You can change the options
from Advanced to Basic by
clicking the appropriate button.

Note that the control panels pic-
tured in the following pages are
from the Advanced settings. 
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The ATI Catalyst® Control Center provides additional video configuration con-
trols and tools which allow quick access to features such as display options, 3D Set-
tings, color and Help menus etc. Adjust settings from the Graphics and Options
menus at the top of the control panel.


Help Menus

Click the Help icon 
and select an option
from the drop down
menu. Press F1 to bring
up Help for any current-
ly selected page.

Figure C - 2
ATI Catalyst Control 

Center Advanced 

Settings
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Attaching Other Displays
Besides the built-in LCD, you can also use an external monitor/flat panel display as
your display device. The following are the display options:

• The built-in LCD.
• An external display connected to the DVI-Out Port.
• An external display/TV connected to the HDMI-Out Port.

HDMI Notes

• Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions provided on the following

pages.
3. Set up your external display (TV or LCD) for HDMI input (see your display device

manual).
4. You can now play video/audio sources through your external display.

HDMI Settings in Other Applications
If you are using a third party application to play DVDs etc. you will need to consult
the application’s documentation to see the appropriate audio configuration (the ap-
plication must support digital to analog translation).


Display Devices

Besides the built-in
LCD, you can also use
an external monitor/flat
panel display as your
display device. The dis-
play options are:

• The built-in LCD.
• An external display 

connected to the DVI-
Out port.

• An external display 
connected to the 
HDMI-Out port.

Note that HDMI sup-
ports video and audio
signals.

DO NOT use the Fn +
F7 key combination to
toggle through display
options when SLI is en-
abled.
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Display Modes

Single
Only one of your displays is used.

Duplicate
Duplicate simply shows an exact copy of the Main display desktop on the other dis-
play(s). This mode will drive multiple displays with exactly the same content, reso-
lution, refresh rates and color quality etc. 

Extend
Extend treats both connected displays as separate devices, and they act as a virtual
desktop resulting in a large workspace. When a display is Extended, you can drag
any icons or windows across to the other display desktop. It is therefore possible to
have one program visible in one of the displays, and a different program visible in
the other display.
Attaching Other Displays C - 5
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Configuring an External Display using the ATI CCC
You can use the ATI Catalyst Control Center to configure any attached displays.

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Open the ATI Catalyst Control Center.
3. Select Desktops & Displays from the Graphics menu in the top left of the screen.
4. Attached displays will appear in the lower part of the screen (click Detect Displays

to find any attached displays that do not automatically appear).
5. Click the triangle icon  (or right-click the display icon) on the attached display

icon to bring up the options (e.g Duplicate or Extend).
6. Select an option from the menu, and click Yes to accept the settings.
7. Click OK to save the changes.


Detect Displays

Click Detect Displays
(button) to automati-
cally update the at-
tached display
information.

You can set a prefer-
ence for automatic dis-
play detection in
Display Options. You
can choose to have at-
tached displays auto-
matically detected
when the ATI CCC is
opened, or to use man-
ual detection only.

Figure C - 3
 Desktops & 

Displays

Attached displays 
will appear here. 
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Configuring an External Display in Win Vista
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click on any of the buttons to configure the displays to your preferences, or click
Display Settings (in the New Display Detected window) to access the control
panel.

Figure C - 4
New Display 

Detected

(Win Vista)
Configuring an External Display in Win Vista C - 7
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Using New Display Detected to Enable Extended Mode
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.


 Display Settings 

Extended Desktop 

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use. 

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure C - 5
New Display 

Detected

(Win Vista)
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Using Display Settings to Enable Extended Mode (Win Vista)
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Open the Display Settings (see “Video Features” on page 1 - 21) control panel.
3. Click the monitor icon (e.g. ), and make sure you have checked “Extend the

desktop onto this monitor” and click Apply.


 Display Settings 

Extended Desktop 

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use.

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure C - 6
Display Settings 

(Extend the Desktop 

Win Vista)

2

Click the appropriate monitor icon
(e.g. ) to be able to select the op-
tion to extend the desktop on to it.

In this example the Primary Dis-
play  is on the left, the Secondary
Display  is on the right.

2

1

2

Configuring an External Display in Win Vista C - 9
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PowerPlay™
PowerPlay™ in the ATI CCC allows you to set your graphics processor settings for
higher performance or longer battery life.

Figure C - 7
PowerPlay™
C - 10 PowerPlay™
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Appendix D: Specifications


Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.
Specifications D - 1
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Processor

Intel® Core™ i3 Mobile Processor:
===============================
350M (2.26GHz)
32nm (32 Nanometer) Process 
Technology, 3MB L3 Cache & 
FSB 1066MHz - TDP 35W
rPGA988A Package
===============================
For Model A, B & C Computers Only:

Intel® Core™ i3 Mobile Processor:
===============================

330M (2.13GHz)
32nm (32 Nanometer) Process 
Technology, 3MB L3 Cache & 
FSB 1066MHz - TDP 35W
rPGA988A Package
===============================

Processor

Intel® Core i5 Mobile Processor:
===============================
540M (2.53GHz)
32nm (32 Nanometer) Process 
Technology, 3MB L3 Cache & 
FSB 1066MHz - TDP 35W
rPGA988A Package

520M (2.40GHz)
32nm (32 Nanometer) Process 
Technology, 3MB L3 Cache & 
FSB 1066MHz - TDP 35W
rPGA988A Package

430M (2.26GHz)
32nm (32 Nanometer) Process 
Technology, 3MB L3 Cache & 
FSB 1066MHz - TDP 35W
rPGA988A Package
===============================

Processor

Intel® Core i7 Mobile Processor:
===============================
820QM (1.73GHz)
45nm (45 Nanometer) Process 
Technology, 8MB L3 Cache & 
FSB 1333MHz - TDP 45W
rPGA988A Package

720QM (1.6GHz)
45nm (45 Nanometer) Process 
Technology, 6MB L3 Cache & 
FSB 1333MHz - TDP 45W
rPGA988A Package

620M (2.66GHz)
32nm (32 Nanometer) Process 
Technology, 4MB L3 Cache & 
FSB 1066MHz - TDP 35W
rPGA988A Package
===============================
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Processor

For Model A, B & C Computers Only:

Intel® Core i7 Mobile Processor:
===============================
840QM (1.86GHz)
45nm (45 Nanometer) Process 
Technology, 8MB L3 Cache & 
FSB 1333MHz - TDP 45W
rPGA988A Package

740QM (1.73GHz)
45nm (45 Nanometer) Process 
Technology, 6MB L3 Cache & 
FSB 1333MHz - TDP 45W
rPGA988A Package
===============================

Processor

For Model B & C Computers Only:

Intel® Core i7 Mobile Processor:
===============================
920XM (2.00GHz)
45nm (45 Nanometer) Process 
Technology, 8M L3 Cache & 
FSB 1333MHz - TDP 55W
rPGA988A Package
===============================

Core Logic

Intel® PM55 Chipset

Display

For Model A Computers:
15.6” (39.62cm) HD (1366 * 768) / 
HD+(1600 * 900) / FHD (1920 * 1080) 
16:9 Wide Screen Backlit LED Panel

Model B & C Computers:
17.3” (43.94cm) HD+(1600 * 900) / FHD 
(1920 * 1080) 16:9 Wide Screen LED 
Backlit Panel

Model D Computers:
15.6” (39.62cm) HD (1366X768) 120Hz 
panel to support 3D solution with 
NV 3D VISION shutter glasses kit

Memory

Dual Channel DDRIII (DDR3) 
Two 204 Pin SO-DIMM Sockets 
Supporting DDRIII (DDR3) 1333MHz
Memory Expandable up to 8GB Using 
4GB DDRIII Modules
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Video Adapter

For Model A Computers:
nVIDIA® GeForce GTX 260M PCIe * 16 
Video Card
1GB GDDR3 Video RAM on board
Supports Microsoft DirectX® 10
Supports HDCP

For Model A & B Computers:
nVIDIA® GeForce GTX 280M PCIe * 16 
Video Card
1GB GDDR3 Video RAM on board
Supports Microsoft DirectX® 10
Supports HDCP

nVIDIA® Quadro QDFX 2800M PCIe * 16 
Video Card
1GB GDDR3 Video RAM on board
Supports Microsoft DirectX® 10
Supports HDCP
Supports DVI Dual-Link
Supports OpenGL 3.1

Video Adapter

For Model A & B Computers:
ATI Radeon HD5870 Series PCIe * 16 
Video Card
1GB GDDR5 Video RAM on board
Supports Microsoft DirectX® 11
Supports HDCP
Supports DVI Dual-link

For Model A, B & D Computers:
nVIDIA® GeForce GTX 285M PCIe * 16 
Video Card
1GB GDDR3 Video RAM on board
Supports Microsoft DirectX® 10
Supports HDCP

nVIDIA® GeForce GTS 360M PCIe * 16 
Video Card
1GB GDDR3 Video RAM on board
Supports Microsoft DirectX® 10
Supports DVI Dual-Link
Supports HDCP

Video Adapter

For Model C Computers:
nVIDIA® GeForce GTX 480M PCIe * 16 
Video Card
2GB GDDR5 Video RAM on board
Supports Microsoft DirectX® 11
Supports HDCP
Supports DVI Dual-Link
Supports HDMI 1.4

BIOS

One 32Mb SPI Flash ROM
Phoenix™ BIOS
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Storage

One Changeable 12.7mm(h) Optical 
Device (CD/DVD) Type Drive (see 
“Factory Options for All Models” on 
page D - 7) 
For Model A & D Computers:
Easy Changeable 2.5" 9.5 mm (h) SATA 
(Serial) HDD
For Model B & C Computers:
2 * Easy Changeable 2.5" 9.5 mm (h) 
SATA (Serial) HDD (RAID 0/1 Support)

Audio

High Definition Audio Compliant Interface
3D Stereo Enhanced Sound System
S/PDIF Digital Output
Built-In Microphone
For Model A & D Computers:
2 * Built-In Speakers
For Model B & C Computers:
5 (including 1 * Subwoofer) Built-In 
Speakers (Supporting 2 Channel Stereo)

Keyboard & Pointing Device

Full Size WinKey Keyboard 
Built-in TouchPad with Multi Gesture 
Function
Three Instant Keys (WWW, E-Mail, Silent 
Mode)

Interface

Three USB 2.0 Ports and One USB 3.0 
Port OR Four USB 2.0 Ports
One eSATA Port
One IEEE1394a Port
One DVI-I (Dual Link) Out Port
One HDMI Out Port
One Headphone-Out Jack
One Microphone-In Jack
One S/PDIF-Out Jack
One Line-In Jack
One RJ-11 Jack
One RJ-45 LAN Jack
One DC-In Jack

Note: External 5.1CH Audio Output 
Supported by Headphone, Microphone 
and Line-In Jacks

Interface

For Model B & C Computers:
One CATV Input Jack for TV Antenna for 
TV Tuner Card Option

Card Reader

Embedded 7-in-1 Card Reader (MS/ MS 
Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS 
Duo) Note: MS Duo/ Mini SD/ RS MMC 
Cards require a PC adapter

Slots

One ExpressCard 34/54 Slot
Two Mini-Card Slots (USB/PCIe):
Slot 1 for Half Mini-Card WLAN Module 
with PCIe Interface (Factory Option)

For Model A & D Computers:
Slot 2 for UMTS/HSPA 3.75G Module with 
USB Interface (Factory Option)

For Model B & C Computers:
Slot 2 for TV Tuner Card with USB 
Interface (Factory Option)
Specifications D - 5



Specifications

D

Communication

Built-In 56K Fax Modem V.90 & V.92 
Compliant (Factory Option)

Built-In 10/100/1000Mb Base-TX Ethernet LAN

Intel® WiFi Link Wireless LAN Module 5300 
3*3 802.11 a/g/n Half Mini-Card with PCIe 
Interface (Factory Option)

Intel® WiFi Link Wireless LAN Module 6200 
2*2 802.11 a/g/n Half Mini-Card with PCIe 
Interface (Factory Option)

Intel® WiFi Link Wireless LAN Module 6300 
3*3 802.11 a/g/n Half Mini-Card with PCIe 
Interface (Factory Option)

3rd Party 802.11b/g/n Half Mini-Card 
Wireless LAN Module with PCIe Interface 
(Factory Option)

Bluetooth 2.1 + EDR (Enhanced Data 
Rate) Module with USB Interface 
(Factory Option)

2.0M Pixel USB PC Camera Module with 
USB Interface (Factory Option)

Communication

For Model A & D Computers:
UMTS/HSPDA-based 3.75G Module with 
USB Mini-Card Interface (Factory Option)
Quad-band GSM/GPRS (850 MHz, 900 
MHz, 1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)
Note that UMTS modes CAN NOT be 
used in North America.

Power Management

Supports Wake on LAN
Supports Wake on USB
Supports Resume From Modem Ring
Limited Energy Star 5.0

Power

For Model A, B & D Computers:
Full Range AC/DC Adapter 
AC input 100 - 240V, 50 - 60Hz, 
DC Output 20V, 6.0A

For Model C Computers Only:
Full Range AC/DC Adapter 
AC input 100 - 240V, 50 - 60Hz, 
DC Output 19V, 9.47A

For All Models:
Removable Polymer Smart Lithium-Ion 
Battery Pack, 42.18WH (3800mAh)

Security

Security (Kensington® Type) Lock Slot
BIOS Password
Fingerprint Reader Module (Factory 
Option)

Operating System

Windows® Vista (with Service Pack 2)
Windows® 7
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Environmental Spec

Temperature 
Operating:   5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Dimensions & Weight

Model A Computers:
374mm (w) * 263.5mm (d) * 42 - 50mm (h)
3.3kg With ODD & Battery

Model B Computers:
412mm (w) * 279mm (d) * 39 - 48mm (h)
4kg With ODD & Battery

Model C Computers:
412mm (w) * 279mm (d) * 39 - 56.8mm (h)
4kg With ODD & Battery

Model D Computers:
374mm (w) * 263.5mm (d) * 42 - 50mm (h)
3.3kg With ODD & Battery

NVIDIA 3D VISION

For Model D Computers:
NVIDIA 3D VISION Shutter Glasses Kit*
*Shutter Glasses Kit includes IR Emitter 
and 1 Pair of Shutter Glasses

NVIDIA 3D VISION Shutter Glasses Only 
(No IR Emiiter Included)

Factory Options for All Models

Built-In 56K Fax Modem V.90 & V.92 
Compliant

Super Multi Drive ODD Module
Blu-Ray ODD Module

Intel® WiFi Link Wireless LAN Module 5300 
3*3 802.11 a/g/n Half Mini-Card with PCIe 
Interface

3rd Party 802.11b/g/n Half Mini-Card 
Wireless LAN Module with PCIe Interface

Bluetooth 2.1 + EDR (Enhanced Data 
Rate) Module

Fingerprint Reader Module

2.0M Pixel USB PC Camera Module

Factory Options Per Model

For Model A & D Computers:
UMTS/HSPDA-based 3.75G Module with 
USB Mini-Card Interface

For Model B & C Computers:
Hybrid TV Tuner Card with USB Interface 
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Windows 7 Information
Appendix E: Windows 7 Information
This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows 7 OS where there are significant differences from Windows Vista, or where is it helpful to have
essential information or features repeated. For items not specifically covered here see the remainder of the man-
ual for information.
E - 1
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DVD Regional Codes

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South Africa, Middle East & Egypt

3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong

4
South & Central America, Mexico, Australia, 
New Zealand

5 N Korea, Russia, Eastern Europe, India & Most of Africa

6 China

Table E - 1 - DVD Region Codes


Changing DVD Regional Codes

Go to the Control Panel and double-click Device Manager (System and Security > System), then click the + next to DVD/CD-ROM
drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is
permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
E - 2 DVD Regional Codes
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Windows 7 Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

Figure E - 1 - Start Menu & Control Panel

Click here to toggle Category View

 

Windows 7 Start Menu & Control Panel E - 3
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Function/Hot Key Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility is installed.

Table E - 2 - Function & Hot Key Indicators

Fn Keys Function Fn Keys Function

Fn + ~ Play/Pause (in Audio/Video Programs) Fn + F5/F6 Volume Decrease/Increase

Fn + _ 
3.75G Module Power 

Toggle*
Fn + F7 Display Toggle

Fn + F1 Touchpad Toggle Fn + F8/F9
Brightness Decrease/

Increase

Fn + F2
Turn LCD Backlight Off

(Press a key to or use TouchPad to turn on)
Fn + F10

PC Camera Power 
Toggle

Fn + F3 Mute Toggle Fn + F11
**WLAN Module Power 

Toggle

Fn + F4  Sleep Toggle Fn + F12
Bluetooth Module Power 

Toggle

*Silent Mode Toggle  

*When enabled, Silent Mode will reduce fan noise and save power 
consumption. Note this may reduce computer performance.

**Make sure that Wireless is ON in the Windows Mobility Center to ensure 
proper wireless function key behavior (see page E - 51).
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Hot Key Buttons & Keyboard
The LED hot key buttons give instant access to the default Internet browser and e-
mail program, and allow you to toggle Silent Mode with one quick button press.

Table E - 3 - LED Hot Key Buttons

*When enabled, Silent Mode will reduce fan noise and save power consumption.
Note this may reduce computer performance.

Hot Key Function

Activate the Default E-Mail Browser (Note that in Windows 7 without Outlook/
Outlook Express installed this button has no function. If Outlook/Outlook Express are
installed then the button will activate the application)

 Activate the Default Internet Program

Toggle *Silent Mode (for power saving)


Other Keyboards

If your keyboard is
damaged or you just
want to make a
change, you can use
any standard USB key-
board. The system will
detect and enable it
automatically. Howev-
er special functions/
hot-keys unique to the
system’s regular key-
board may not work.

NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable num-
ber or scroll lock, and
check the LED indica-
tor for status.



Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLk is on.
Hot Key Buttons & Keyboard E - 5
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Video Features
This computer features two different (either ATI or NVIDIA) video options. You will be provided with an ap-
propriate driver on the Device Drivers & Utilities + User’s Manual Disc. You can switch display devices, and con-
figure display options, from the Display control panel (in Appearances and Personalization) in Windows 7.
For more detailed video information see Chapter B“NVIDIA Video Driver Controls” from page B - 1/ Chapter
C“ATI Video Driver Controls” from page C - 1.

To access Display (Control Panel) and Screen Resolution in Windows:
1. Click Start and click Control Panel.
2. Click Display (icon) - In the Appearances and Personalization category.
3. Click Adjust Screen Resolution/Adjust resolution.
OR
4. Alternatively you can right-click the desktop and select Screen resolution (see right).
5. Use the dropbox to select the screen Resolution  (Figure E - 2 on page E - 7).
6. Click Advanced settings  (Figure E - 2 on page E - 7) to bring up the Advanced properties tabs.

To access the NVIDIA Control Panel (See Appendix B for detailed information):
1. Click Start, and click Control Panel.
2. Click NVIDIA Control Panel  (Figure E - 3 on page E - 8) - In the Appearances and Personalization

category.
3. See “NVIDIA Video Driver Controls” on page B - 1 for full details on control panels etc.

To access the ATI Catalyst Control Center (See Appendix C for detailed information):
1. Right-click the desktop and select Catalyst(TM) Control Center  (Figure E - 4 on page E - 9).
2. See “ATI Video Driver Controls” on page C - 1 for full details on control panels etc.

1
2

3

6
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Screen Resolution
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display as
your display device.

Figure E - 2 - Screen Resolution

1

2


Video Options

Note that card types, specifications
and drivers are subject to continual
updates and changes. Check with
your service center for the latest de-
tails on video cards supported.
Video Features E - 7
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NVIDIA Control Panel
You can also access the NVIDIA Control Panel as follows:

1. Click Start and click All Programs > NVIDIA Corporation.
2. Click to select NVIDIA Physx Properties .
OR
3. Click Advanced settings in the Screen Resolution control panel in Windows.
4. Click GeForce....(tab) and click Start the NVIDIA Control Panel .

Figure E - 3 - NVIDIA Control Panel

4

5

3

4 5
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ATI Catalyst® Control Center
You can also access the ATI Catalyst® Control Center as follows:

1. Click Start and click All Programs (or just click Start and select ATI CCC ).
2. Click Catalyst Control Center.
3. Click ATI CCC (Advanced/Wizard).
OR
4. Double-click the taskbar icon  . Note that you can add the ATI icon  to the taskbar (Enable System

Tray Menu) from the Catalyst Control Center’s Options > Preferences menu .

Figure E - 4 - ATI Catalyst® Control Center

7

8
9

8
9

7

6

Video Features E - 9
E



Windows 7 Information

E

Attaching Other Displays
Configuring an External Display in Windows 7
1. Attach your external display to the external monitor port/HDMI-Out port and turn it on.
2. Go to the Screen resolution control panel.
3. Click the Detect button.
4. The computer will then detect any attached displays.

Figure E - 5 - Screen Resolution - Multiple Displays
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5. You can configure the displays from the Multiple Displays menu.

Figure E - 6 - Screen Resolution - Multiple Display Options

• Duplicate these displays - Shows an exact copy of the main display desktop on the other display(s)
• Extend these displays - Treats both connected displays as separate devices
• Show desktop only on 1/2 - Only one of your displays is used.

See “Attaching Other Displays” on page B - 6/“Attaching Other Displays” on page C - 4 for more details on
the above modes when using the NVIDIA/ATI driver to configure attached displays.
Attaching Other Displays E - 11
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Using the Fn + F7 Key Combination to Switch Displays
You can also use the Fn + F7 key combination to quickly change display configura-
tion and modes.

1. Attach your external display to the external monitor port/HDMI-Out port and turn it on.
2. Press the Fn + F7 key combination.
3. An on-screen menu will pop up.
4. Use the cursor keys (or Fn + F7) to select the appropriate configuration from the

menu, and press Enter to confirm the selection.

Figure E - 7
 Fn + F7 Display 

Configuration 

Selection
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page E - 25).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page E - 21.


Silent Mode

Use the  key to tog-
gle Silent Mode to re-
duce fan noise and save
power consumption.
Note this may reduce
computer performance.
The Power Sources E - 13
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Turning On the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options in the Windows control panel to configure this feature.


Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

Power Button as 
Stand by or 

Hibernate Button

You can use the OS’s
“Power Options” control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page E
- 19 for details).


Shut Down

Note that you should always shut your computer down by choosing the Shut Down com-
mand from the Lock Button Menu in Windows 7. This will help prevent hard disk or system
problems.
E - 14 Turning On the Computer
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.


Resuming 
Operation

See Table E - 4, on
page E - 20 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure E - 8
Power Plan 

Advanced Settings
Power Plans E - 15
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure E - 9
Power Plans

Click to Show/Hide 
additional 
power plans
E - 16 Power Plans
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where you left off. Sleep is the
default power-saving state in Windows 7.

Earlier versions of Windows used Stand By and Hibernate as system power-saving states. Windows 7 combines
the features of Stand By and Hibernate into the default Sleep power-saving state.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the system sleeps. When you are
not using your computer for a certain length of time, which you specify in the operating system, it will enter
Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left off (what was on your desk-
top) without reopening the application(s) and file(s) you last used.

If your mobile PC in Sleep is running on battery power the system will use only a minimum amount of power.
After an extended period the system will save all the information to the hard disk and shut the computer down
before the battery becomes depleted.
Power-Saving States E - 17
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down
You should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan to
be away from the computer for several days, or you do not need it to wake up and run
a scheduled task. Returning to full operation from Shut down takes longer than from
Sleep or Hibernate.

Figure E - 10
Lock Button Menu
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the computer in to a power-
saving state. Click Choose what the power buttons do on the left menu in Power Options to bring up the menu.


Password Protection

It is recommended that you
enable a password on wake
up in order to protect your
data.

However you can disable
this setting from the Power
Options menu by clicking
Require a password on
wakeup in the left menu,
and selecting the options
(click Change settings that
are currently unavailable).

Figure E - 11
Power Options Define 

Power Buttons
Configuring the Power Buttons E - 19
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Resuming Operation
You can resume operation from power-saving states by pressing the power button, or in some cases pressing the
sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad


Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table E - 4
Resuming 

Operation


Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).
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Battery Information
Follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
E - 8 on page E - 15).

Click the battery icon  in the taskbar to see the current battery level and charge
status.


Low Battery 

Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure E - 12
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
Battery Information E - 21
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.


Wireless Hot Keys

The computer’s wireless
function keys will not func-
tion properly if Wireless is
turned OFF in the Win-
dows Mobility Center
control panel.

The wireless indicators
 may show that

the WLAN module is pow-
ered on, however if wire-
less is OFF in the Mobility
Center, the module will not
be powered on. 

Make sure that Wireless is
ON in the Mobility Center to
ensure proper function key
behavior.

Figure E - 13
Windows Mobility 

Center
Make sure Wireless is ON to ensure proper function key behavior.
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life and improve its perfor-
mance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason
(e.g. long term storage) see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page E - 25 for instruc-
tions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical out-
let. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the
computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “Model Differ-
ences” on page 1 - 6 for information on the battery charge status, and to “Battery Information” on page E - 21
for more information on how to maintain and properly recharge the battery pack.)
Battery Information E - 23
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Proper handling of the Battery Pack
•DO NOT disassemble the battery pack under any circumstances
•DO NOT expose the battery to fire or high temperatures, it may explode
•DO NOT connect the metal terminals (+, -) to each other


Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.


Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
E - 24 Battery Information
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even
if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut
down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after creating it) and click Change plan settings > Change advanced power 

settings.

Figure E - 14 - Create Power Plan - Discharge Battery
Battery Information E - 25
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

Figure E - 15 - Power Options Advanced Settings - Battery

• Low battery levels = 0%
• Critical battery Levels = 0%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing


Battery Charging & 

Maintenance

How do I fully charge the battery?
When charging the battery, don’t stop
until the LED charging indicator light
changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the
battery at least once every 30 days or
after about 20 partial discharges.
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
disc, click Install Drivers/Option Drivers (button) and
then click the appropriate driver name from the Drivers
Installer menu. Follow the instructions to install the
driver. Alternatively click Start, navigate (Browse..) to
the executable file and then follow the manual setup in-
structions.

Figure E - 16 - Drivers Installer Screen 1

1. Check the driver installation order from Table E - 5 (the 
drivers must be installed in this order) which is the 
same as that listed in the Drivers Installer menu 
below.

2. Click to select the driver you wish to install, (you 
should note down the drivers as you install them).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

Note: If you need to reinstall any driver, you should uninstall the
driver first.

Figure E - 17 - Drivers Installer Screen 2
Driver Installation E - 27
E



Windows 7 Information

E

Table E - 5 - Driver Installation

Windows 7 Drivers Page # Windows 7 Drivers Page #

Chipset Page E - 29 PC Camera Module (Win7) Page E - 40

NVIDIA Video
ATI Video

Page E - 30 Wireless LAN Module (Win 7) Page E - 33

Audio Page E - 31 Fingerprint Reader Module (Win7) Page E - 33

Modem Page E - 30
3.75G/HSPA Module (Win 7) (Models A & 
Only)

Page E - 56

LAN Page E - 30 TV Tuner Module (Models B & C Only) Page 7 - 46

Firewire (IEEE 1394) Page E - 30 NVIDIA 3D Shutter Glasses Kit Page 7 - 48

CardReader Page E - 31
Setting Up SATA RAID or AHCI Modes 
(RAID for Models B & C Only)

Page 7 - 52

TouchPad Page E - 31

Hot Key Page E - 31

USB 3.0 Page E - 31

Audio Page E - 31
E - 28 Driver Installation
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Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may
be necessary to uninstall the original driver.To do this go
to the Control Panel in the Windows OS and double-
click the Programs and Features item (Programs >
Uninstall a program). If you see the individual driver
listed (if not see below), uninstall it, following the on
screen prompts (it may be necessary to restart the com-
puter). Go to the appropriate section of the manual to
complete the update/reinstall procedure for the driver in
question.

If the driver is not listed in the Programs and Features
item:

1. Click Start and click Control Panel. 
2. Double-click System (icon); System (icon) is in 

System and Security (category).
3. Click Device Manager (in the left menu).
4. Double-click the device you wish to update/reinstall the 

driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver 

tab) and follow the on screen prompts.

Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.


Driver Installation General Guidelines

The driver installation procedure outlined in this
Chapter are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.
Driver Installation E - 29
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NVIDIA Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.
OR
ATI Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Install.
3. Click the Express (or Custom if you prefer to 

manually configure the driver installation set-
tings) button and click Next.

4. Click Accept (button) and click Yes.
5. Click Finish.

Modem
1. Click 3.Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.

LAN
1. Click 4.Install LAN Driver > Yes. 
2. Click Next > Install.
3. Click Finish.
4. The network settings can now be configured.

Firewire (IEEE 1394)
1. Click 5.FireWire drivers > Yes. 
2. Click Install.
3. Click Finish.
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CardReader
1. Click 6.Install Cardreader Driver > Yes.
2. Click Install.
3. Click Finish.

TouchPad
1. Click 7.Install Touchpad Driver > Yes.
2. Choose the language you prefer and click OK.
3. Click Next > Finish.
4. Click Restart Now to restart the computer.

Hot Key
1. Click 8.Install Hotkey Utility > Yes. 
2. Click Next > Next.
3. Click Finish > Finish to restart the computer.

USB 3.0
1. Click 9.Install USB 3.0 Utility > Yes. 
2. Click Next.
3. Click the button to accept the license and then 

click Next.
4. Click Next > Install.
5. Click Finish.

Audio
1. Click 10.Install Audio Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, eject
the Device Drivers & Utilities + User’s Manual disc
and then reinsert it (or double-click the disc icon in My
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.
Driver Installation E - 31
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Optional Drivers
See the pages indicated for the driver installation procedures for any modules included in your purchase option.
Where Windows 7 information differs from Windows Vista it will be included in this chapter; if Windows 7 in-
formation is the same as Windows Vista then refer to Chapter 7 as indicated on the following page. 

Figure E - 18 - Drivers Installer - Option Drivers Menu
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Bluetooth Module (Win 7)
Note: The operating system is the default setting for Bluetooth control in Windows 7, and does not require a
driver. See “Bluetooth Module (Win 7)” on page E - 35 for configuration instructions.

PC Camera Module (Win 7)
See “PC Camera Module (Win7)” on page E - 40 for driver installation and configuration information.

Wireless LAN Module (Win 7)
See the specific Windows 7 driver installation and configuration information in “Wireless LAN Module (Win
7)” on page E - 46.

Fingerprint Reader Module (Win 7)
See the introduction in “Fingerprint Reader Module (Win7)” on page E - 52, and check the installation proce-
dure.
Driver Installation E - 33
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3.75G/HSPA Module (Win 7 - Models A & D Only)
See the introduction in “3.75G/HSPA Module (Win 7)” on page E - 56, and check the installation procedure.

TV Tuner Module (Models B & C Only)
See the introduction in “TV Tuner Module” on page 7 - 45, and check the installation procedure for the Con-
sumer Infrared (CIR) driver.

NVIDIA 3D Shutter Glasses (Model D Only)
See the introduction in “NVIDIA 3D Shutter Glasses Kit” on page 7 - 48. The NVIDIA Video Driver is required
to support the 3D glasses.

RAID and AHCI Configuration 
(RAID for Models B & C Only)
See the configuration instructions in “Setting Up SATA RAID or AHCI Modes” on page 7 - 52. The Intel Ma-
trix driver is required to support hard disk in RAID or AHCI modes (see “Intel Matrix Driver Installation” on
page 7 - 57).
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Bluetooth Module (Win 7)
The operating system’s Bluetooth Devices control panel is used to configure the
Bluetooth settings in Windows Vista, and therefore does not require a driver. Use the
Fn + F12 key combination (see “Function/Hot Key Indicators” on page E - 4) to
toggle power to the Bluetooth module. When the Bluetooth module is powered on,
the  LED will be illuminated and the on-screen indicator will briefly be displayed.
If you are experiencing problems connecting to some Bluetooth devices see “Blue-
tooth Connection Problems” on page 8 - 16.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see Table 1
- 6, on page 1 - 12/ Table 1
- 3, on page 1 - 9).


Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is sup-
ported in one direction only (simultaneous data transfer is not supported). Therefore
if you are copying a file from your computer to a Bluetooth enabled device, you will not be
able to copy a file from the Bluetooth enabled device to your computer until the file transfer
process from the computer has been completed.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
state. Use the key combination (Fn + F12) to power on the Bluetooth module after the com-
puter resumes from Sleep.
Bluetooth Module (Win 7) E - 35
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Bluetooth Configuration in Windows Vista

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module. 
2. A Bluetooth icon  will appear in the taskbar.
3. You can then do any of the following to access the Bluetooth Devices control

panel.

• Double-click the taskbar icon  to access the Bluetooth Devices control panel.

• Click/Right-click the taskbar icon  and choose an option from the menu.


Add a Device

Click Start, and click
Control Panel and then
click Devices and
Printers (Hardware
and Sound). Click Add
a device to search for
any available Bluetooth
devices.

Figure E - 19
Bluetooth Devices & 

Click Icon Menu

Add a device

Right-Click Taskbar Icon 
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To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.

3. On first connection the computer will provide you with a pairing code to be entered 
onto the device.


Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure E - 20
Add a Device
Bluetooth Module (Win 7) E - 37
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4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

5. Windows will check to see if any drivers are required to complete the pairing. 
6. Follow any on-screen instructions on the computer if device drivers are required to

be installed.
7. Click Close.

Figure E - 21
Pairing Code 

Example

Figure E - 22
Pairing Complete & 
Bluetooth Device 

Enabled


Pairing Codes

The example outlined here shows a connection to
a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.
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To Change Settings for the Bluetooth Device
1. Click the taskbar icon and select Show Bluetooth Devices.
2. Right-click on the device you want to change and click Properties to:

• Change the name of the device (click Bluetooth, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Click the taskbar icon and select Open Settings.
2. Click Options, and make sure that Allow Bluetooth devices to find this 

computer check box (Discovery) has a tick inside it.
3. Make sure that the Alert me when a new Bluetooth device wants to connect 

check box (Connections) has a tick inside it, if you want to be notified when a 
Bluetooth device wants to connect.


Bluetooth Help

To get help on Bluetooth
configuration and set-
tings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box, and
select an item from the re-
turned search results to
get more information.

Figure E - 23
Bluetooth Settings - 

Options
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PC Camera Module (Win7)
If you have included a PC Camera module in your purchase option, make sure that
the PC Camera module is on before installing the driver. Use the Fn + F10 key com-
bination (see “Function/Hot Key Indicators” on page 1 - 12) to toggle power to
the PC Camera module. When the PC Camera module is powered on, the on-screen
indicator will briefly be displayed. Make sure you install the drivers in the order in-
dicated in Table E - 5, on page E - 28.

There are a number of different camera modules available with this computer model
series. You will have the appropriate application installed for your camera. Make
sure you access the application via the WebCam desktop shortcut.


Latest PC Camera 
Driver Information

Check the Device Driv-
ers & Utilities + User’s
Manual disc, and any
accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here.


PC Camera Device and TV Module

If you have both an optional PC Camera and an optional TV Tuner module present, you will
need to select which device to use with the BisonCap program. Go to the Devices menu
in the BisonCap application and select the BisonCam, NB Pro device.
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PC Camera Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc 

into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 1.PC Camera, Web cam > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish.
6. Run the camera application program from the shortcut on the desktop (if the hardware is turned off use 

the Fn + F10 key combination to turn it on again).

PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in
Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to the level required.
7. Click OK and close the control panels.
8. Run the camera application program from the desktop shortcut.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
PC Camera Module (Win7) E - 41
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Camera Application
The WebCam application is a video viewer for general purpose video viewing and
testing, and for capturing video files to .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you 
set the capture file before the capture process - see “Set Capture File” on 
page E - 43).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera
Audio Setup” on page E - 41) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the
video, and press Esc to stop the capture (you can view the file using the Windows
Media Player).


Pre-Allocating File 

Size/Space

You may pre-allocate the
file size (File > Allocate
File Size/Space) for the
capture file in the camera
program (you may need
to set a folder location
first).

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

See also “Reducing Vid-
eo File Size” on page E -
43.
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Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file
name and location before capture (this will help avoid accidentally overwriting files). Set the name and location
then click Open, then set the "Capture file size:" and click OK. You can then start the capture process as on
the previous page.

Note the important information in reducing video file size below in order to save file space, and help pre-
vent system problems.

Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk space for each file. After
recording video, check the video file size (right-click the file and select Properties) and the remaining free space
on your hard disk (go to My Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows 7 system requires a minimum of 15GB of free space on the C: drive system partition. In
order to prevent system problems it is recommended that you save the captured video file to a location other than
the C: drive (see set capture file above), limit the file size of the captured video (see “Pre-Allocating File Size/
Space” on page E - 42) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the camera application program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
4. Click OK.
PC Camera Module (Win7) E - 43
E



Windows 7 Information

E

Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to
adjust the setting in the Video Capture Filter options.

1. Run the camera program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency/Powerline Frequency.

Figure E - 24
Video Capture Filter
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Zoom
The WebCam program allows you to zoom the camera in and out (note the zoom
function is not available in all camera model applications).

1. Run the camera application from the desktop shortcut.
2. Go to Zoom and select Zoom Out/Zoom In.

Taking Still Pictures
The WebCam program allows you to take still pictures.

1. Run the camera application from the desktop shortcut.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder  on the 

desktop (see sidebar).

Figure E - 25
Zoom/Setting


Snapshot Folder

The Snapshot folder’s de-
fault location is on the desk-
top. Do not move this folder
or an error may appear
when you try to take a still
picture.

If you accidentally delete or
move the folder, you can
create a new Snapshot
folder on the desktop in or-
der to capture the files.
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Wireless LAN Module (Win 7)
If you have included an Intel® Wi-Fi Link Series or 3rd Party 802.11b/g/n WLAN
module in your purchase option, make sure that the Wireless LAN module is on be-
fore installing the driver.

Use the Fn + F11 key combination (see “Function/Hot Key Indicators” on page 1 -
12) to toggle power to the Wireless LAN module. When the WLAN module is pow-
ered on, the  LED will be illuminated and the on-screen indicator will briefly be dis-
played. Make sure you install the drivers in the order indicated in Table 4 - 1, on
page 4 - 3.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 6, on
page 1 - 12/ Table 1 - 4, on
page 1 - 9).
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Intel® Wi-Fi Link Series Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc 
into the CD/DVD drive. 

2. Click Option Drivers (button).
3. Click 2.Wireless Lan > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Next > Finish.

Note: The operating system is the default setting for Wireless LAN control in Windows 7 (see overleaf).

3rd Party 802.11b/g/n Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc 

into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Wireless Lan > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish to restart the computer.

Note: The operating system is the default setting for Wireless LAN control in Windows 7 (see overleaf).
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Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then double-click an access point to connect 
to or click to Open Network and Sharing Center if you do not see a network you 
want to connect to in the taskbar menu (a list of options will appear allowing setting 
changes, and creating a new network).


Network and 

Sharing Center

You can also use the Net-
work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure E - 26
Click Taskbar Icon 
Menu & Network 

and Sharing Center
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2. You may need to enter a security key for any access point to which you are trying
to connect.

3. Click to select a network location (e.g. Home, Work or Public).
4. Click “View or change settings in Network and Sharing Center” to access

further options for the connection.
Figure E - 27

Network Location 
Set
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5. Click the taskbar icon  to see any currently connected networks.
6. To disconnect from the wireless network you can click the taskbar wireless icon ,

click the active connection and then click Disconnect (button).


Security Enabled 

Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure
networks may allow unau-
thorized access to your
computer, documents,
websites and files etc.

Figure E - 28
Click Taskbar Icon 
Menu - Disconnect
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Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon  to access the network 

menu.


Wireless Hot Keys

The computer’s wireless
function keys will not func-
tion properly if Wireless is
turned OFF in the Win-
dows Mobility Center
control panel.

The wireless indicators
 may show that

the WLAN module is pow-
ered on, however if wire-
less is OFF in the Mobility
Center, the module will not
be powered on. 

Make sure that Wireless is
ON in the Mobility Center to
ensure proper function key
behavior.

Figure E - 29
Windows Mobility 

Center


Windows Mobility 

Center

The Windows Mobili-
ty Center control pan-
el provides an easy
point of access for in-
formation on battery
status, power plans
used and wireless de-
vice status etc.

Make sure Wireless is ON to ensure proper function key behavior.
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Fingerprint Reader Module (Win7)
The optional fingerprint reader module provides a high level of security for your
computer. Make sure you have administrator’s rights to your computer, and have a
Windows password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the
fingerprint tutorial. To run the tutorial click Start > Programs/All Programs > Pro-
tector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 3.FingerPrint > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.


Help & Manual

Right-click the taskbar icon
 to bring up the menu to

select Help.

Insert the Device Drivers &
Utilities + User’s Manual
disc and click Option Driv-
ers (button). Click Unlock
(button) and then click
3.FingerPrint >Yes.

Click Documentation to
open the folder containing
the manual in .pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User’s Man-
ual disc and click User’s
Manual (button), and click
Install Acrobat Reader
(button).
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User Enrollment
1. Click Start > Control Center (Start > All Programs > Protector Suite > Control 

Center), or double click the taskbar icon .
2. On the first run of the program you will be asked to click the Accept button to

accept the license.
3. If you have not set a Windows password you will be prompted to do so (note: If

you have not set a password Protector Suite cannot secure access to your
computer).

4. Click Submit when you have entered password.
5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get

help with fingerprint enrollment at any time).

Figure E - 30
Fingerprint 
EnrollmentTutorial
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6. Click the button above any of the fingers to begin the enrollment process for that
finger.

7. Swipe the finger until the progress bar reaches 100% to enroll that finger.
8. Repeat the process for all the fingers you wish to enroll (see sidebar), and then click

the close  button to close the window.


Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure E - 31
Fingerprints 

Enrolled
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9. Click the taskbar icon  and select Start Control Center (and then swipe a
finger) to allow you to Edit Fingerprints, register Applications, edit Settings and
access the Help menu etc. You can also run the Control Center from the Start
menu or Protector Suite > Control Center item in the All Programs menu.

10. Click “Help” in Control Center Home to get more information on any topic.
11. You can also run the Tutorial, or Product Tour video to get more information.

12. If you swipe your finger over the reader at any time you can access the Biomenu
to lock the computer, register websites, access the Personal Safe, open the
Control Center and access the Help menu.

Figure E - 32
Fingerprint Control 
Center & Biomenu

Help
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3.75G/HSPA Module (Win 7)
(Optional for Model A & D Computers Only)
If you have included an optional 3.75G/HSPA (High Speed Packet Access) module
(see “Communication” on page D - 6 for specification details) in your purchase op-
tion, you will have the appropriate application (HSPA Modem Interface or Mobile
Partner) provided for your module. Follow the instructions on page E - 58 to install
the USIM card (supplied by your service provider), and then install the application
(see over for further details).


3.75G/HSPA Module 

Options

There are two optional
3.75G/HSPA modules
available for this series
of computer models.
Each module is supplied
with the appropriate ap-
plication software.

The module type sup-
plied may depend upon
the computer model pur-
chased. Check with your
service center for de-
tails.

Install the driver from
the Drivers Installer
menu and check the in-
structions for the appro-
priate application on the
following pages.


Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module
and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio fre-
quency, and cause interference. When the 3.75G/HSPA module is powered on, make sure
that the Bluetooth/Wireless LAN modules are powered off.
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Before installing the application, make sure that the 3.75G/HSPA module is ON
(installing the driver with the module off will not allow the software to detect the
module hardware correctly). Use the Fn +  key combination (see “Function/Hot
Key Indicators” on page E - 4) to toggle power to the 3.75G/HSPA module. When
the 3.75G/HSPA module is powered on, the on-screen indicator will briefly be dis-
played. Make sure you install the drivers in the order indicated in Table E - 5, on
page E - 28. Note that exiting the application does NOT turn off the 3.75G/HSPA
module.

• HSPA Modem Interface - See “HSPA Modem Interface Installation” on 
page E - 60 for driver installation information and “HSPA Modem Interface” 
on page E - 61 for instructions on using the HSPA Modem Interface.

• Mobile Partner - See “Mobile Partner Application Installation” on page E - 
70 for driver installation information and “Mobile Partner Application” on 
page E - 71 for instructions on using the Mobile Partner application.


3.75G/HSPA 

Modules & System 
Wake Up

Note that the 3.75G mod-
ules DO NOT support
system wake up on
3.75G/HSPA modem ac-
tivity.
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USIM Card Installation
1. Turn off the computer, and turn it over and remove the battery (see “Removing the 

Battery” on page 6 - 3).
2. The SIMLOCK is located in the compartment under the battery.
3. Remove screw  from the SIMLOCK cover, and remove the cover.
4. Insert the USIM card as you would into your mobile phone.


Power Safety 

Warning

Before you undertake
any installation proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Figure E - 33
Battery & SIMLOCK 

Cover Removal

1

Model A

SIMLOCK Location

1
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5. Slide the SIMLOCK towards the hinge (in the direction of the arrow illustrated in 
Figure E - 34) in order to release the lock and lift it up.

6. Insert the USIM card as illustrated in (Figure E - 35) and close the SIMLOCK.

7. Lock the SIMLOCK by pushing it in the direction of the arrow in Figure E - 35 until 
it clicks into the lock position.

8. Replace the cover, screw and battery.

Figure E - 34
Unlock the 
SIMLOCK

Figure E - 35
SIMLOCK Lock

Model A

A
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HSPA Modem Interface
With the 3.75G/HSPA module and USIM card (supplied by your service provider)
installed you may then install the HSPA Modem Interface. The HSPA Modem In-
terface allows you to directly access your HSPA internet service from the computer.

HSPA Modem Interface Installation

1. Enable power to the module by pressing the Fn +  key combination (the 
on-screen indicator will indicate the module’s power status). If a Found New 
Hardware window appears, click Cancel in all windows that appear, and 
then proceed to install the driver as below.Insert the Device Drivers & Utili-
ties + User’s Manual disc into the CD/DVD drive.

2. Click Option Drivers (button).
3. Click 4.3.5 Generation Module > Yes.
4. Click Next > Install.
5. Click Finish to restart the computer.
6. Access the HSPA Modem Interface from the Start menu (Start > Pro-

grams/All Programs > HSPA modem), or by double-clicking the HSPA 
modem icon on the desktop.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn +  key com-
bination to toggle power to
the 3.75G/HSPA module,
and check the indicator to
see if the module is pow-
ered on or not (see Table 1
- 6, on page 1 - 12/ Table 1
- 4, on page 1 - 9).
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HSPA Modem Interface
The connection information is stored on the USIM card supplied by the service pro-
vider.

1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the HSPA Modem Interface from the Start menu (Start > Programs/All

Programs > HSPA Modem > HSPA Modem), or by double-clicking the desktop
icon .

3. If a USIM card is not installed then a message will appear to notify you of this (click
OK to close the message and install the USIM card).

4. If you are required to enter a pin # then a message will appear to prompt you to
enter a pin #. (Note: to change pin # go to Settings  and click OK in PIN
code.)

5. Click the Network connection  button and the HSPA Modem interface
window will display Connection Manager.


HSPA Modem Help

To get help on 3.75G/
HSPA module configu-
ration and settings, click
the help icon  and
select Help.

Figure E - 36
HSPA Modem 

Interface Window


Connection Manager

The connection information is commonly stored on the USIM
card supplied by the service provider. However if your ser-
vice provider requires details such as IP Address, User-
name and Password etc. to be entered before connection
you can enter them in the Connection Manager tab, or
save the details in Profiles.
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6. Click Connect  to connect to your service provider.

7. The message “Network is connected” will be displayed when the network
connection is successful. 

8. You can then access the internet, download e-mail etc. as per any internet
connection.

Figure E - 37
Connecting to 

Network

Figure E - 38
Network is 
Connected
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9. While you are connected the upper right corner of the HSPA Modem interface will
display the upload and download rates, and the taskbar icon will display the
connection icon .

10. To disconnect click the Disconnect  icon (Connection Manager).
11. The program will disconnect from the service provider.
12. The module will still be on, and you will need to press the Fn +  key combination

to turn it off.

Adding a Profile
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click the Network connection , and click Profiles (tab).

Figure E - 39
Uploading/

Downloading Rates 
and Speed

Figure E - 40
Profiles
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3. Click Add (button) and input any Network Settings required by your service
provider.

4. Click OK to save the profile.

5. You can Edit or Delete profiles from the Profiles tab.
6. To use a profile click to select it, and then click Apply (button) and the settings will

be transferred to Connection Manager.

Figure E - 41
Network Settings & 

Profiles
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Contacts
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Contacts  (button).

3. Click Refresh (button) to download the contacts from the USIM card to the
computer.

4. The Contacts will then be displayed.
5. Double-click any contact to edit the information (or right-click and select Edit).
6. You can also Export/Import contacts by clicking the appropriate button.

Figure E - 42
Network Settings & 

Profiles
3.75G/HSPA Module (Win 7) E - 65
E



Windows 7 Information

E

Messages
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Messages  (button).

3. Click Refresh (button) to download the messages from the USIM card to the
computer.

4. Click New (button) to create a new message.
5. You can either type the telephone number in the recipient field, or press To (button)

to select the contact from the list.


SMS Service

In addition to standard in-
ternet services you may
also send and receive
SMS text messages us-
ing the HSPA Modem In-
terface, if your service
supports SMS.

Figure E - 43
Network Settings & 

Profiles
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6. Click to select a contact from the list and then click Add (button) and the phone number will automatically be 
added to the recipient field.

7. Type the message information into the message body and click Send (button) to send it, or Save to draft 
(button) to save the message.

8. Select any message to forward or delete it, or to reply to it.
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Settings
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Settings  (button).

Figure E - 44
Settings
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3. Click OK alongside any of the options to configure the settings.
4. The Network can be configured for an Automatic (usually from the USIM card) or

Manual connection.
5. The Network Mode can be configured for any appropriate mode required.

6. You can also change your settings for the Pin #, and input your phone number.
7. Exiting the program DOES NOT turn off the 3.75G/HSPA module, and you will

need to press the Fn +  key combination to turn off the module (pay careful
attention to this aboard aircraft - see “Wireless Device Operation Aboard
Aircraft” on page E - 60).

8. If the module is on and the computer enters a power-saving state, then the power
status of the module on resuming from the power-saving state will be as below:

• If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted; 
the module will be off when the computer starts up.

• If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate; 
the module will be off when the computer resumes from sleep.

Figure E - 45 
Settings - Network/

Network Mode
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Mobile Partner
With the 3.75G/HSPA module and USIM card (supplied by your service provider)
installed you may then install the Mobile Partner application. The Mobile Partner
application allows you to directly access your HSPA internet service from the com-
puter.

Mobile Partner Application Installation

1. Enable power to the module by pressing the Fn +  key combination (the 
on-screen indicator will indicate the module’s power status). If a Found New 
Hardware window appears, click Cancel in all windows that appear, and 
then proceed to install the driver as below.Insert the Device Drivers & Utili-
ties + User’s Manual disc into the CD/DVD drive.

2. Click Option Drivers (button).
3. Click 4.3.5 Generation Module > Yes.
4. Choose the language you prefer and click OK.
5. Click Next.
6. Click I Agree (button) to accept the license agreement.
7. Click Next > Install.
8. Click Finish.
9. Access the Mobile Partner application from the Start menu (Start > Pro-

grams/All Programs > Mobile Partner), or by double-clicking the Mobile 
Partner icon on the desktop.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn +  key com-
bination to toggle power to
the 3.75G/HSPA module,
and check the indicator to
see if the module is pow-
ered on or not (see Table 1
- 6, on page 1 - 12/ Table 1
- 4, on page 1 - 9).
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Mobile Partner Application
You will need to contact your service provider to obtain the exact details of how ex-
actly to configure the settings on this page.

Profile Management
1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the Mobile Partner application from the Start menu (Start > Programs/All

Programs > Mobile Partner), or by double-clicking the Mobile Partner icon on the
desktop .

3. If you have not created a profile, click Tools and select Options, and then click
Profile Management.

4. Click New  and input the appropriate information for Profile Name, APN
and Authentication etc. as supplied by your service provider.

5. Click Save  to save the profile.


Mobile Partner Help

To get help on Mobile
Partner configuration
and settings, click the
Help menu and select
Online Help or press
F1.

Figure E - 46
Profile Management
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Connecting to the Service Provider
1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the Mobile Partner application from the Start menu (Start > Programs/All

Programs > Mobile Partner), or by double-clicking the Mobile Partner icon on the
desktop .

3. The software will run and you can select the Profile Name from the menu.
4. Click Connect  to begin the connection process.

5. The Mobile Partner application will then display the connection information.

Figure E - 47 
Connect

Figure E - 48
Network 

Connection Prompt
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6. When the connection is successful you can click the network icon in the taskbar to
display the connection information.

7. You can then access the internet, download e-mail etc. as per any internet
connection.

8. While you are connected the indicators in the Mobile Partner window will display
uploading and downloading icons and a network icon in the taskbar .

Figure E - 49
Connected 

Taskbar 
Notification
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9. To disconnect click the Disconnect  icon, or right click the taskbar icon,
click the connected icon  and select Disconnect.

10. The program will disconnect from the service provider.
11. The module will still be on, and you will need to press the Fn +  key combination

to turn it off.

Figure E - 50
Disconnect
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12. The module will still be on, and you will need to press the Fn +  key combination
to turn it off.

13. If you click the Mobile Partner close icon  a message will be displayed asking
you to click OK to confirm the program exit and to terminate the connection. 

14. Exiting the program terminates the connection, but DOES NOT turn off the 3.75G/
HSPA module, and you will need to press the Fn +  key combination to turn off
the module (pay careful attention to this aboard aircraft - see “Wireless Device
Operation Aboard Aircraft” on page E - 70).

15. If the module is on and the computer enters a power-saving state, then the power
status of the module on resuming from the power-saving state will be as below:

• If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted; 
the module will be off when the computer starts up.

• If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate; the 
module will be off when the computer resumes from sleep.

Figure E - 51
Exit Prompt
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Audio Setup for LCD Monitors/TVs with HDMI Input
Some LCD monitors/TVs support HDMI input, but DO NOT have built-in digital audio decoders. Where this is
the case, when playing DVDs in Windows Media Player/CyberLink Power DVD etc., a background noise can
occur. If this situation does arise then please follow the instructions below.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Double-click Realtek Digital Output.
4. Click Supported Formats (tab).
5. Click to disable (remove the check in the box) DTS Audio and Dolby Digital.
6. Click OK and close the control panels.

 Figure E - 52 - Sound Supported Formats
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